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A quick reference guide to the  
Landscape Species Selection Software version 2.1 

TECHNICAL MANUAL 5 
==October 2006=

Successful conservation planning  
bÑÑÉÅíáîÉ= ïáäÇäáÑÉ= ÅçåëÉêî~íáçå= êÉèìáêÉë= íÜ~í= ïÉ= ÅçåJ
ëáÇÉê= íÜÉ= ÅçãéäÉñ= ãáñ= çÑ= ÄáçäçÖáÅ~äI= ëçÅá~ä= ~åÇ= ÉÅçJ
åçãáÅ=Ñ~Åíçêë=íÜ~í=áåÑäìÉåÅÉ=íÜÉ=ÉÅçäçÖáÅ~ä=áåíÉÖêáíó=çÑ=
~å= ~êÉ~I= ~åÇ= íÜÉå= ÑçÅìë= çìê= ÅçåëÉêî~íáçå= ÉÑÑçêíë= çå=
íÜçëÉ=~ÅíáîáíáÉë=íÜ~í=ïáää=Ü~îÉ=íÜÉ=ãçëí=éçëáíáîÉ=áãé~Åí=
çå= ïáäÇäáÑÉ= éçéìä~íáçåë= ~åÇ= íÜÉáê= Ü~Äáí~íK= = qÜáë= êÉJ
èìáêÉë=íÜ~í=ïÉ=Ü~îÉ=~=ÅäÉ~ê=ìåÇÉêëí~åÇáåÖ=çÑ=åçí=çåäó=
íÜÉ=ÉÅçäçÖáÅ~ä=åÉÉÇë=çÑ=ïáäÇäáÑÉ=ëéÉÅáÉë=Äìí=~äëç=íÜÉ=ÜìJ
ã~å=~ÅíáîáíáÉë=íÜ~í=áãéáåÖÉ=çå=íÜÉãK=
=
qÜÉ=i~åÇëÅ~éÉ=péÉÅáÉë=^ééêç~ÅÜ=Eip^FI=ÇÉîÉäçéÉÇ=Äó=
íÜÉ=t`p=iáîáåÖ=i~åÇëÅ~éÉë=mêçÖê~ãI=éêçîáÇÉë=íÜÉ=ÅçJ
ÜÉêÉåí=Ñê~ãÉïçêâ=~åÇ=éê~ÅíáÅ~ä=íççäë=åÉÉÇÉÇ=íç=ÖìáÇÉ=
ëáíÉJÄ~ëÉÇ=ÅçåëÉêî~íáçå=Ä~ëÉÇ=çå=íÜÉ=åÉÉÇë=çÑ=ïáäÇäáÑÉ=
ïáíÜáå= ä~êÖÉ= ä~åÇëÅ~éÉë= çÑ= Üìã~å= áåÑäìÉåÅÉK= = qÜáë=
ëíÉéJÄóJëíÉé= éêçÅÉëë= Ñçê= éä~ååáåÖ= ~åÇ= áãéäÉãÉåíáåÖ=
ÅçåëÉêî~íáçå=~ÅíáîáíáÉë=áåÅäìÇÉëW=ENF=ÅçåÅÉéíì~ä=ãçÇÉäë=
Ñçê= ÅäÉ~êäó=ÇÉÑáåáåÖ=~=éêçÖê~ãÛë=Öç~äë= ~åÇ=çÄàÉÅíáîÉëI=
EëÉÉ= qÉÅÜåáÅ~ä= j~åì~ä= OFX= EOF= ~= é~êíáÅáé~íçêó= ~éJ
éêç~ÅÜ= Ñçê=éêáçêáíáòáåÖ=~åÇ=ã~ééáåÖ=Üìã~å=~ÅíáîáíáÉë=
íÜ~í= íÜêÉ~íÉå= ä~åÇëÅ~éÉë=~åÇ=íÜÉ=ïáäÇäáÑÉ=ïáíÜáå= íÜÉã=
EëÉÉ=qÉÅÜåáÅ~ä=j~åì~ä=NFX=EPF=~å=çÄàÉÅíáîÉ=~åÇ=íê~åëJ
é~êÉåí=éêçÅÉëë= Ñçê= ëÉäÉÅíáåÖ=~=ÅçãéäÉãÉåí~êó=ëìáíÉ=çÑ=
í~êÖÉí= ëéÉÅáÉë= íÜ~íI= áÑ= ÅçåëÉêîÉÇI=ïáää= ÜÉäé= éêçíÉÅí= ~ää=
íÜÉ=ÄáçÇáîÉêëáíó=ëÜÉäíÉêÉÇ=ìåÇÉê=íÜÉáê=ÅçääÉÅíáîÉ=ÅçåëÉêJ
î~íáçå= Å~åçéó= = EáKÉKI= i~åÇëÅ~éÉ= péÉÅáÉëFX= EQF= éêçÅÉJ
ÇìêÉë= Ñçê=ãçÇÉäáåÖ=Ü~Äáí~í=èì~äáíó=çÑ=i~åÇëÅ~éÉ=péÉJ
ÅáÉë= ~åÇ= Ñçê= ãçÇÉäáåÖ= íÜÉ= áãé~Åíë= çÑ= Üìã~åJÅ~ìëÉÇ=

íÜêÉ~íë=çå=Ü~Äáí~í=èì~äáíó=EëÉÉ=qÉÅÜåáÅ~ä=
j~åì~ä=SFX= ERF=ÖìáÇÉäáåÉë= Ñçê=ÅêÉ~íáåÖ=~=
“`çåëÉêî~íáçå=i~åÇëÅ~éÉÒ=íç=ÑçÅìë=ÅçåJ
ëÉêî~íáçå= ~ÅíáîáíáÉë= ëé~íá~ääóX= ESF= ~= é~êJ
íáÅáé~íçêó= éêçÅÉëë= Ñçê= éêáçêáíáòáåÖ= ~åÇ=
ëíê~íÉÖáÅ~ääó=éä~ååáåÖ= áåíÉêîÉåíáçåëX= ~åÇ=
ETF= ÖìáÇÉäáåÉë= Ñçê= ÇÉîÉäçéáåÖ= ÉÑÑÉÅíáîÉ=
ãçåáíçêáåÖ= Ñê~ãÉïçêâë= EëÉÉ= qÉÅÜåáÅ~ä=
j~åì~ä=PFK===
=
qÜáë= íÉÅÜåáÅ~ä= ã~åì~ä= áë= ~= èìáÅâ= êÉÑÉêJ
ÉåÅÉ=ÖìáÇÉ=íç=íÜÉ=ëçÑíï~êÉ=ÇÉîÉäçéÉÇ=Äó=
íÜÉ=iáîáåÖ=i~åÇëÅ~éÉë=mêçÖê~ã=~ë=~=ÇÉJ
Åáëáçå= ëìééçêí= íççä= Ñçê= íÜÉ= ëÉäÉÅíáçå= çÑ=
íÜÉ= i~åÇëÅ~éÉ= péÉÅáÉëK= qÜÉ= ã~åì~ä= áë=
áåíÉåÇÉÇ= íç= ÄÉ= ìëÉÇ= Ü~åÇJáåJÜ~åÇ= ïáíÜ=
íÜÉ= i~åÇëÅ~éÉ= péÉÅáÉë= pÉäÉÅíáçå= ëçÑíJ
ï~êÉK==cçê=ãçêÉ=ÇÉí~áäÉÇ=áåÑçêã~íáçå=çå=
íÜÉ= ëçÑíï~êÉI= éäÉ~ëÉ= Åçåëìäí= íÜÉ= ÉäÉÅJ
íêçåáÅ=ÜÉäé=ÑáäÉ=íÜ~í=~ÅÅçãé~åáÉë=áíK===
=
i~åÇëÅ~éÉ= péÉÅáÉë= ~êÉ= ÇÉÑáåÉÇ= Äó= íÜÉáê=
ìëÉ= çÑ= ä~êÖÉI= ÉÅçäçÖáÅ~ääó= ÇáîÉêëÉ= ~êÉ~ëI=
íÜÉ=Ñ~Åí=íÜ~í=íÜÉó=éä~ó=áãéçêí~åí=êçäÉë=áå=
ã~áåí~áåáåÖ= íÜÉ= ëíêìÅíìêÉ= ~åÇ= ÑìåÅíáçå=
çÑ=å~íìê~ä=ÉÅçëóëíÉãëI=~åÇ= íÜÉáê=ëìëÅÉéJ
íáÄáäáíó=íç=Üìã~å=~äíÉê~íáçå=çÑ=ïáäÇ=ä~åÇJ
ëÅ~éÉëK===
=

Obtaining the Software or Other  
Living Landscapes Program Resources 
 

The Landscape Species Selection software can 
be obtained by email from conservationsup-
port@wcs.org. Other Living Landscapes Program 
technical manuals, papers or bulletins detailing 
the Landscape Species Approach or the selec-
tion process can be obtained in the same way. 
We recommend that you read the papers by 
Sanderson et al. 2002 and Coppolillo et al. 
2004, as well as Bulletins 1-4, before proceed-
ing with the selection of Landscape Species. 
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i~åÇëÅ~éÉ=péÉÅáÉë=~êÉ=ëÉäÉÅíÉÇ=Ä~ëÉÇ=çåW=
ENF=~å=~ÖÖêÉÖ~íÉ=ëÅçêÉ=ïÜáÅÜ= áë= íÜÉ=ëìã=
çÑ=ÑáîÉ=ÅêáíÉêá~=E^êÉ~=oÉèìáêÉãÉåíëI=eÉíJ
ÉêçÖÉåÉáíóI= sìäåÉê~ÄáäáíóI= bÅçäçÖáÅ~ä=
cìåÅíáçå~äáíóI= ~åÇ= pçÅáçJÉÅçåçãáÅ= páÖJ
åáÑáÅ~åÅÉFX=~åÇ=EOF=Üçï=ïÉää=É~ÅÜ=ëéÉÅáÉë=
ÅçãéäÉãÉåíë= íÜÉ= Ü~Äáí~íëI= ã~å~ÖÉãÉåí=
òçåÉëI= ~åÇ= íÜêÉ~íë= êÉéêÉëÉåíÉÇ= Äó= íÜçëÉ=
ëéÉÅáÉë=~äêÉ~Çó=ëÉäÉÅíÉÇ=Ñçê=íÜÉ=ëìáíÉK=
=
qç= ëÉäÉÅí= i~åÇëÅ~éÉ= péÉÅáÉë= óçì= ã~ó=
éìí=íçÖÉíÜÉê=~=ëÉäÉÅíáçå=íÉ~ã=~í=óçìê=ëáíÉ=
ÅçãéêáëÉÇ= çÑ= ÑáÉäÇ= ÄáçäçÖáëíëI= ã~å~ÖÉJ
ãÉåí= éÉêëçååÉä= ~åÇ= çíÜÉêë= ïáíÜ= äçÅ~ä=
ÉñéÉêíáëÉ= çê= âåçïäÉÇÖÉ= çÑ= íÜÉ= ëéÉÅáÉë=
ÄÉáåÖ=Éî~äì~íÉÇK= =b~ÅÜ=ëíÉé= áå= íÜÉ=éêçÅJ
Éëë=EëÉÉ=_çñ=_F=ïáää=ÄÉ=ÇÉëÅêáÄÉÇ=~åÇ=áäJ
äìëíê~íÉÇ=ïáíÜ=Ç~í~=ÑçêI=~åÇ=êÉëìäíë=ÑêçãI=
íÜÉ= i~åÇëÅ~éÉ= péÉÅáÉë= ëÉäÉÅíáçå= Ñçê= íÜÉ=
k~ã=h~ÇáåÖ=i~åÇëÅ~éÉI=i~ç=maoK=

Selecting Seascape Species 
 

Although we refer to Landscape Species 
throughout this technical manual, this process 
for selecting surrogate species on which to fo-
cus conservation attention has also been ap-
plied to marine settings.  For example, Sea-
scape Species have successfully been selected 
for the Glover’s Reef Seascape, a tropical Atoll 
that forms part of the Belize Barrier Reef sys-
tem, and for the Sea and Sky Seascape, a huge 
ecosystem encompassing the Patagonian shelf 
and associated offshore waters.  

Installing and Running the  
Landscape Species Selection Software 

 

Having obtained the zip file with the software’s installation files, 
extract all three files it contains (setup.exe, Setup.lst and Speci-
esSelection.cab) to the same temporary directory.  Run the setup 
program (setup.exe) that guides you through the installation proc-
ess.  After installation run the Landscape Species Selection soft-
ware via the Programs | Landscape Species Selection folder off 
the Start menu on your Windows Taskbar.  Further information is 
provided in the installation README file that can be obtained 
together with the software installation files (as can example data 
and project files to help you understand how the software works).  
Additionally, under Programs | Landscape Species Selection you 
will find the detailed online help file for the software (press the 
F1 function key when the software is running to open the help 
file).  If you are running the software for the first time, create a 
new project (press Ctrl+N – the Control and N key simultane-
ously), type in data or import it, and remember to save (Ctrl+S) 
your project data frequently (See Box A).  Any project file can be 
re-opened during subsequent sessions (Ctrl+O).  

 Select New from the Project menu to start a 
new species selection software project file and 
Open to retrieve an existing project file.

Select New from the Project menu to start a 
new species selection software project file and 
Open to retrieve an existing project file.

Select Save from the 
Project menu to save 
an existing species 
selection software 
project file and Exit to 
close the application.

Select Save from the 
Project menu to save 
an existing species 
selection software 
project file and Exit to 
close the application.

Select Import from the Data menu to 
import tab delimited text files into the 
various data tables.

Select Import from the Data menu to 
import tab delimited text files into the 
various data tables.

Select Save from the Graph
menu to save any one of the 
summary graphs as a bitmap 
image file for inclusion in other 
documents.

Select Save from the Graph
menu to save any one of the 
summary graphs as a bitmap 
image file for inclusion in other 
documents.

Select Export from the 
Data menu to save the 
information in data 
tables to tab delimited 
text files that can easily 
be included in reports.

Select Export from the 
Data menu to save the 
information in data 
tables to tab delimited 
text files that can easily 
be included in reports.

Select Copy from the 
Graph menu to allow 
for any one of the 
summary graphs to     
be pasted into other 
documents.

Select Copy from the 
Graph menu to allow 
for any one of the 
summary graphs to     
be pasted into other 
documents.

Manipulate the Landscape Species 
Selection software’s project files, 
import and export  data and save 
graphs using the application’s menus. 

Landscape Species Selection Software Menus Box A 
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péÉÅá~ä=ÉäÉãÉåíë=~êÉ=íóéáÅ~ääó=ÉåÇÉãáÅ=çê=
Ü~îÉ= îÉêó= äçÅ~ä= ÇáëíêáÄìíáçåëI= Ü~îÉ= îÉêó=
ëéÉÅáÑáÅ=Ü~Äáí~í=åÉÉÇë=åçí=êÉéêÉëÉåíÉÇ=Äó=
íÜÉ= ëìáíÉ= çÑ= i~åÇëÅ~éÉ= péÉÅáÉëI= çê= ~êÉ=
íÜêÉ~íÉåÉÇ=Äó=ëéÉÅáÑáÅ=éêçÅÉëëÉë=åçí=êÉéJ
êÉëÉåíÉÇ= Äó= íÜÉ= ëìáíÉK= = péÉÅá~ä= ÉäÉãÉåíë=
~êÉ= ÇÉëÉêîáåÖ= çÑ= ÅçåëÉêî~íáçå= ~ííÉåíáçå=
áå= íÜÉáê= çïå= êáÖÜíI= Äìí= ÇìÉ= íç= íÜÉ= áåÇáJ
îáÇì~äáòÉÇ=å~íìêÉ=çÑ=íÜÉ=~Åíáçåë=êÉèìáêÉÇ=
íç= ÅçåëÉêîÉ= íÜÉãI= íÜÉó= éêçîáÇÉ= äáííäÉ= çÑ=
íÜÉ= ëìêêçÖ~íÉ= ÑìåÅíáçå= íÜ~í= íÜÉ= i~åÇJ
ëÅ~éÉ= péÉÅáÉë= éêçîáÇÉK= = tÉ= ÜáÖÜäó= êÉÅJ
çããÉåÇ= íÜ~í= ~ÑíÉê= ëÉäÉÅíáåÖ= i~åÇëÅ~éÉ=
péÉÅáÉëI= óçì= ÅçåëáÇÉê= ïÜ~í= ëéÉÅáÉë= çê=
îÉÖÉí~íáçå= ÅçããìåáíáÉë= ã~ó= Ü~îÉ=
ëäáééÉÇ=íÜêçìÖÜ=íÜÉ=Åê~ÅâëK==`çåëìäí=íÜÉ=
fr`k= oÉÇ= iáëí= EïïïKáìÅåêÉÇäáëíKçêÖFI=
ã~âÉ= ~= åçíÉ= çÑ= íÜÉ= ÉåÇÉãáÅë= çê= ê~åÖÉJ
êÉëíêáÅíÉÇ=ëéÉÅáÉë=áå=óçìê=ä~åÇëÅ~éÉI=~åÇ=
íÜÉå= ~ëâ= óçìêëÉäÑ= “fÑ= ïÉ= ëìÅÅÉëëÑìääó=
ÅçåëÉêîÉÇ=íÜÉ=i~åÇëÅ~éÉ=péÉÅáÉëI=ïçìäÇ=
ïÉ= ÄÉ= éêÉííó= ëìêÉ= íÜ~í= íÜÉëÉ= çíÜÉê= ÉäÉJ
ãÉåíë= ïçìäÇ= ~äëç= ÄÉ= ÅçåëÉêîÉÇX= ~åÇ= áÑ=
åçíI=ëÜçìäÇ=ïÉ=~áã=ëçãÉ=çÑ=çìê=ÅçåëÉêJ
î~íáçå=êÉëçìêÅÉë=ÇáêÉÅíäó=~í=íÜÉã\Ò

Landscape Species as ‘surrogate’  
conservation targets   
tÜáäÉ=ãçëí=ÅçåëÉêî~íáçåáëíë=~ëéáêÉ=íç=ÅçåëÉêîÉ=ãçëíI=áÑ=
åçí=~ääI=å~íáîÉ=ÄáçÇáîÉêëáíó=áå=çìê=éä~ÅÉë=çÑ=áåíÉêÉëíX=~ë=
dêçîÉë=EOMMPF=éçáåíë=çìíI=“áí= áë=ëáãéäó=áãéê~ÅíáÅ~ä=íç=
íÜáåâ= ~Äçìí= éä~ååáåÖ= áåÇáîáÇì~ä= ÅçåëÉêî~íáçå= ÉÑÑçêíë=
Ñçê= ~ää= íÜÉëÉ= ÉäÉãÉåíëÒK= = qç= çéÉê~íÉ= ÉÑÑÉÅíáîÉäóI= ïÉ=
åÉÉÇ= íç= ÑçÅìë= çìê= éä~ååáåÖ= ~åÇ= ~Åíáçå= çå= ~= ãìÅÜ=
ëã~ääÉê= ëìÄëÉí= çÑ= ÄáçÇáîÉêëáíóI= Å~ääÉÇ= “ÅçåëÉêî~íáçå=
í~êÖÉíëÒK=

i~åÇëÅ~éÉ=péÉÅáÉë=~êÉ= ÅçåëÉêî~íáçå= í~êÖÉíëI=Äìí=ãçêÉ=
ëéÉÅáÑáÅ~ääóI=íÜÉó=~êÉ=“ëìêêçÖ~íÉëÒ=Ó=ÉäÉãÉåíë=çÑ=ÄáçÇáJ
îÉêëáíó= ëÉäÉÅíÉÇI= ~í= äÉ~ëí= áå= é~êíI= ~ë= êÉéêÉëÉåí~íáîÉë= çÑ=
çíÜÉê=ÉäÉãÉåíë=çÑ=ÄáçÇáîÉêëáíóK= =tÉ=ÜçéÉ=íÜ~í=ÅçåëÉêJ
î~íáçå=~áãÉÇ=~í= íÜáë= ëã~ää= ëìáíÉ=çÑ=i~åÇëÅ~éÉ=péÉÅáÉë=
ïáää= éêçîáÇÉ= ëìÄëí~åíá~ä= ÅçåëÉêî~íáçå= ÄÉåÉÑáí= íç= íÜÉ=
çíÜÉê= Ñçêãë= çÑ= ÄáçÇáîÉêëáíó= ïáíÜáå= çìê= ä~åÇëÅ~éÉëI=
ê~åÖáåÖ=Ñêçã=çíÜÉê=ëéÉÅáÉë=íç=îÉÖÉí~íáçå=ÅçããìåáíáÉë=
~åÇ=ÉÅçëóëíÉãëK==i~åÇëÅ~éÉ=ëéÉÅáÉë=~êÉI=~ë=óçì=ïáää=ëÉÉ=
áå= íÜáë= ã~åì~äI= ÉñéäáÅáíäó= ëÉäÉÅíÉÇ= íç= êÉéêÉëÉåí= íÜÉ=
ìåáèìÉ= Ü~Äáí~íëI= ã~å~ÖÉãÉåí= òçåÉë= ~åÇ= íÜÉ= ÅêáíáÅ~ä=
íÜêÉ~íë=ïáíÜáå=çìê=ä~åÇëÅ~éÉëK==_ó=ÉñéäáÅáíäó=ÅçåëáÇÉêJ
áåÖ=Ü~Äáí~íëI=ã~å~ÖÉãÉåí=òçåÉë=~åÇ=íÜêÉ~íëI=ïÉ=ÜçéÉ=
íç=ëÉäÉÅí=~=ëìáíÉ=çÑ=ëéÉÅáÉë=ïÜáÅÜI=áå=íçí~äI=Ñçêã=~å=ÉÑJ
ÑÉÅíáîÉ=ÅçåëÉêî~íáçå=ìãÄêÉää~=Ñçê=íÜÉ=çíÜÉê=å~íáîÉ=ëéÉJ
ÅáÉë=áå=çìê=ä~åÇëÅ~éÉëK=
=
^êÉ= íÜÉ= i~åÇëÅ~éÉ= péÉÅáÉë= ëìÑÑáÅáÉåí= íç= êÉéêÉëÉåí= ~ää=
íÜÉ= å~íáîÉ= ÄáçÇáîÉêëáíó= óçì= ïçìäÇ= äáâÉ= íç= ÅçåëÉêîÉ\==
qÜÉ=~åëïÉê=áë=ãçëí=äáâÉäó=“åçÒK==_ÉáåÖ=Äêç~ÇJê~åÖáåÖ=
~åÇ=çÑíÉå= ÖÉåÉê~äáëí= áå= å~íìêÉI=i~åÇëÅ~éÉ= péÉÅáÉë= ~êÉ=
“Åç~êëÉ= ÑáäíÉêÒ= ÅçåëÉêî~íáçå= í~êÖÉíë= Ó= íÜÉó= ~êÉ=ãÉ~åí=
íç=Å~éíìêÉ=ãçëí=çíÜÉê=ÉäÉãÉåíë=çÑ=ÄáçÇáîÉêëáíóI=Äìí=ïÉ=
Çç=åçí= ÉñéÉÅí= íÜÉã= íç=ÄÉ=éÉêÑÉÅíK= = pçãÉ= ÉäÉãÉåíë= çÑ=
ÄáçÇáîÉêëáíóI=íÜ~í=ïÉ=Å~ää=“ëéÉÅá~ä=ÉäÉãÉåíëÒI=~êÉ=äáâÉäó=
íç= ëäáé= íÜêçìÖÜ= íÜÉ= Åê~Åâë= ~åÇ=ïáää= åçí= ÄÉ= ÉÑÑÉÅíáîÉäó=
ÅçåëÉêîÉÇ= Äó= ~Åíáçåë= ~áãÉÇ= ~í= i~åÇëÅ~éÉ= péÉÅáÉëK==

Definitions for Conservation Targets 
 

There is a large and bewildering variety of terms, with slightly 
different meanings for different people, used to discuss conser-
vation targets.  Aside from the terms we have chosen to use 
(conservation targets and surrogates), others include “focal spe-
cies”, “umbrella species”, “keystone species”, and “flagships”.   
Try not to get too bogged down in finding the perfect term, as 
there probably is none.  Also do not assume that other people 
have a clear definition of the terms in their heads.  We recom-
mend that when talking to others about these concepts, use 
terms you are all comfortable with and define them clearly. 
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Step 1: Define the set of =
 candidate species 
 

qÜÉ= Ñáêëí= ëíÉé=ïÜÉå= ëÉäÉÅíáåÖ=i~åÇëÅ~éÉ=
péÉÅáÉë=áë=íç=áÇÉåíáÑó=~=éççä=çÑ=Å~åÇáÇ~íÉ=
ëéÉÅáÉë=Ñêçã=ïÜáÅÜ=íÜÉ=Ñáå~ä=ëìáíÉ=ïáää=ÄÉ=
ÅÜçëÉå=EëÉÉ=_çñ=`FK==qç=~îçáÇ=~å=ìåÇìäó=
çåÉêçìë= ëÉäÉÅíáçå= éêçÅÉëëI= ïÉ= ëìÖÖÉëí=
íÜ~í=íÜÉ=áåáíá~ä=éççä=çÑ=Å~åÇáÇ~íÉë=Åçåëáëí=
çÑ= ~ää= ëéÉÅáÉë= íÜ~í= Ü~îÉ= ~= êÉ~ëçå~ÄäÉ=
ÅÜ~åÅÉ= çÑ= ÄÉáåÖ= ëÉäÉÅíÉÇI= ÄÉÅ~ìëÉ= íÜÉó=
ÉñÜáÄáí= çåÉ= çê=ãçêÉ= çÑ= íÜÉ= ÑáîÉ= ÅêáíÉêá~=
EÇÉëÅêáÄÉÇ=ìåÇÉê=píÉé=PF=íç=~=ëáÖåáÑáÅ~åí=
ÇÉÖêÉÉK= = fí= áë= ~äëç= áãéçêí~åí= íç= áåÅäìÇÉ=

ëéÉÅáÉë= çÅÅìéóáåÖ= íÜÉ= Ñìää= ê~åÖÉ= çÑ= Ü~Äáí~í= íóéÉë= ~åÇ=
ã~å~ÖÉãÉåí=òçåÉëI=~åÇ=ÄÉáåÖ=áãé~ÅíÉÇ=Äó=íÜÉ=ÅêáíáÅ~ä=
íÜêÉ~íë= áå= íÜÉ= ä~åÇëÅ~éÉI= ÉîÉå= íÜçìÖÜ= ~åó= é~êíáÅìä~ê=
ëéÉÅáÉë=ã~ó= åçí= ÉñÉãéäáÑó= ~ää= çÑ= íÜÉ= i~åÇëÅ~éÉ= péÉJ
ÅáÉëÛ= ÅÜ~ê~ÅíÉêáëíáÅëK= = qÜáë= áë= ëáÖåáÑáÅ~åí= ÄÉÅ~ìëÉ= íÜÉ=
ëìáíÉ=çÑ=i~åÇëÅ~éÉ=péÉÅáÉë=áë=~ëëÉãÄäÉÇ=Ä~ëÉÇ=çå=ÅçãJ
éäÉãÉåí~êáíó= áå= íÉêãë= çÑ= Ü~Äáí~í= íóéÉëI= ã~å~ÖÉãÉåí=
òçåÉë= ~åÇ= íÜêÉ~íë= EÅçãéêáëáåÖ= íÜÉ=eÉíÉêçÖÉåÉáíó= ~åÇ=
sìäåÉê~Äáäáíó=ÅêáíÉêá~FI= ëìÅÜ=íÜ~í=ëçãÉ=ëéÉÅáÉë=ã~ó=ÄÉ=
áåÅäìÇÉÇ= Äó= îáêíìÉ= çÑ= íÜÉáê= ÅçãéäÉãÉåí~êáíó= ~äçåÉI=
ÉîÉå=íÜçìÖÜ=íÜÉó=Çç=éççêäó= áå=íÉêãë=çÑ=çíÜÉê=ÅÜ~ê~ÅJ
íÉêáëíáÅë=E^êÉ~=oÉèìáêÉãÉåíëI=bÅçäçÖáÅ~ä=cìåÅíáçå~äáíóI=
ÉíÅKFK= =tÉ= ~äëç= êÉÅçããÉåÇ= íÜ~í= íÜÉ= ëÉäÉÅíáçå= éêçÅÉëë=
ëÜçìäÇ= ÑçÅìë= çå= ëéÉÅáÉë= ïÜçëÉ= éçéìä~íáçåë= áå= óçìê=

 Step 1 - Define the Set of Candidate Species 

To remove a candidate 
species (e.g., Oriental 
Small-Clawed Otter) 
enter its row No. (7) and 
then press the Remove 
species no. button.

Enter the number of 
candidate species to be 
added to the current 
set and then press the 
Update species list
button.

Candidate species 
common and scientific 
names should not 
contain any commas,  
nor should the former 
have blank values.

To change the order of 
candidate species 
select the species by 
clicking on its row and 
then click the up arrow 
or down arrow button.

Once you have identified your set of candidate species enter their common and scientific names by either (i)  typing the 
data into the table or (ii) reading the data from a file (see Data -> Import on the software menus figure or the online help). 

Assemblages of species can be 
problematic during habitat suitability  
or threat modeling (step after 
selection), unless their requirements 
& threats are very similar. However, 
in this case this was the only option, 
as it is unknown which of two bear 
species occur in the landscape. 

To remove a candidate 
species (e.g., Oriental 
Small-Clawed Otter) 
enter its row No. (7) and 
then press the Remove 
species no. button.

To remove a candidate 
species (e.g., Oriental 
Small-Clawed Otter) 
enter its row No. (7) and 
then press the Remove 
species no. button.

Enter the number of 
candidate species to be 
added to the current 
set and then press the 
Update species list
button.

Enter the number of 
candidate species to be 
added to the current 
set and then press the 
Update species list
button.

Candidate species 
common and scientific 
names should not 
contain any commas,  
nor should the former 
have blank values.

Candidate species 
common and scientific 
names should not 
contain any commas,  
nor should the former 
have blank values.

To change the order of 
candidate species 
select the species by 
clicking on its row and 
then click the up arrow 
or down arrow button.

To change the order of 
candidate species 
select the species by 
clicking on its row and 
then click the up arrow 
or down arrow button.

Once you have identified your set of candidate species enter their common and scientific names by either (i)  typing the 
data into the table or (ii) reading the data from a file (see Data -> Import on the software menus figure or the online help). 

Assemblages of species can be 
problematic during habitat suitability  
or threat modeling (step after 
selection), unless their requirements 
& threats are very similar. However, 
in this case this was the only option, 
as it is unknown which of two bear 
species occur in the landscape. 

Assemblages of species can be 
problematic during habitat suitability  
or threat modeling (step after 
selection), unless their requirements 
& threats are very similar. However, 
in this case this was the only option, 
as it is unknown which of two bear 
species occur in the landscape. 

Box C 

 Box B 
=

Stepping Through the Landscape Species Selection Software=
To select Landscape Species with the help of the software follow the steps shown below: 

Step 5 – Use the Software as a Decision Support Tool to 
Select Your Complementary Suite of Landscape Species
Step 5 – Use the Software as a Decision Support Tool to 
Select Your Complementary Suite of Landscape Species

Step 2 – Specify the 
Parameters for Your Landscape
Step 2 – Specify the 
Parameters for Your Landscape

Step 3 – Enter Values for the 5 Selection 
Criteria for Each Candidate Species
Step 3 – Enter Values for the 5 Selection 
Criteria for Each Candidate Species

Step 4 – Examine and Refine Your Species Selection DataStep 4 – Examine and Refine Your Species Selection Data

Step 1 – Define the Set 
of Candidate Species
Step 1 – Define the Set 
of Candidate Species

1
2

3

4

5
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ä~åÇëÅ~éÉ= ~êÉ= ÅìêêÉåíäó= áå= íêçìÄäÉ= EáKÉKI= Ñ~ê= ÄÉäçï=
ãáåáãìã=îá~ÄäÉ=éçéìä~íáçåëI=ÉÅçäçÖáÅ~ä=ÇÉåëáíáÉëI=çê=
ÅçåëÉêî~íáçå= éçéìä~íáçå= í~êÖÉíëF= çê= íÜçëÉ= íÜ~í= ~êÉ=
îìäåÉê~ÄäÉ=íç=ã~àçê=éçéìä~íáçå=ÇÉÅäáåÉë=áå=íÜÉ=ÑìíìêÉ=
EçîÉê=íÜÉ=åÉñí=NMJOR=óÉ~êëI=ÇÉéÉåÇáåÖ=çå=óçìê=éä~åJ
åáåÖ=ÜçêáòçåFK=
=
Step 2: Specify the parameters for  
 your landscape 
 

qç=ÇÉÑáåÉ=íÜÉ=éêçéÉêíáÉë=çÑ=óçìê=ä~åÇëÅ~éÉ=~åÇ=ÅÉåJ
íê~ä= ÇÉí~áäë= çÑ= íÜÉ= ëÉäÉÅíáçå= éêçÅÉëëI= ëéÉÅáÑó= íÜÉ= ÑçäJ
äçïáåÖ=EëÉÉ=_çñ=aFW======
~K=qÜÉ=e~Äáí~í=qóéÉë=áå=óçìê=ä~åÇëÅ~éÉI=íÜÉ=ëìêÑ~ÅÉ=

~êÉ~=çÑ=É~ÅÜI=~åÇ=íÜÉ=äÉîÉä=çÑ=ìëÉ=êÉèìáêÉÇ=íç=êÉéJ
êÉëÉåí= É~ÅÜ= Ü~Äáí~íK= = fåÅäìÇÉ= Ü~Äáí~í= íóéÉë= êÉJ
èìáêÉÇ=Äó=É~ÅÜ=Å~åÇáÇ~íÉ= ëéÉÅáÉë= íç= ÅçãéäÉíÉ= áíë=
äáÑÉ=ÅóÅäÉ=çê=íÜçëÉ=íÜ~í=~êÉ=ÅêáíáÅ~ä=íç=íÜÉ=ã~áåíÉJ
å~åÅÉ=çÑ=ÉÅçäçÖáÅ~ääó=ÑìåÅíáçå~ä=éçéìä~íáçåë=EíÜÉ=
êÉëçäìíáçå= çÑ= íÜÉ= Ü~Äáí~í= Å~íÉÖçêáÉë= ëÜçìäÇ= ÄÉ=
ëìÅÜ= íÜ~í= ~= ëéÉÅáÉë= ïçìäÇ= ÇáëíáåÖìáëÜ= ÄÉíïÉÉå=
íÜÉãFK==`çåëáÇÉê=Ü~Äáí~í=íóéÉë=íÜ~í=~êÉ=~ÄëçäìíÉäó=
êÉèìáêÉÇ=Äó=ëéÉÅáÉë=áå=íÉêãë=çÑW=ENF=åìíêáíáçå=EÉKÖKI=
îÉÖÉí~íáçå=ÅçããìåáíáÉë=çê=~êÉ~ë=íÜ~í=ëìééäó=ÇáÑÑáJ
ÅìäíJíçJÑáåÇ=åìíêáÉåíë=ëìÅÜ=~ë=ë~äí=äáÅâëFX=EOF=ï~íÉê=
EÉKÖKI= ä~âÉëI=ëíêÉ~ãëI=êáîÉêëI=ä~ÖççåëFX=EPF=ëÉÅìêáíó=

çê=íÜÉêã~ä=ÅçîÉê=EîÉÖÉí~íáçå=ÅçããìJ
åáíáÉëFX= EQF= êÉéêçÇìÅíáçå= ~åÇ= ÖêçïíÜ=
EÉKÖKI= ëé~ïåáåÖ= ëáíÉëI= ÇÉååáåÖ= Ü~ÄáJ
í~íI= åÉëíáåÖ= ëáíÉëFX= ~åÇ= ERF=ãáÖê~íçêó=
ÅçêêáÇçêëK==fÑ=óçìê=ä~åÇëÅ~éÉ=Ü~ë=ÇáëJ
íáåÅí= ëÉ~ëçå~äáíó= çê= ÅóÅäÉë= EÉKÖKI= bä=
ká¥ç= ÅóÅäÉëI= ÇêóLïÉí= ëÉ~ëçåI=ïáåíÉêL
ëìããÉêFI= ÅçåëáÇÉê= íÜÉ= Ü~Äáí~í= íóéÉë=
êÉèìáêÉÇ=Äó=Å~åÇáÇ~íÉ=ëéÉÅáÉë=íç=ëìêJ
îáîÉ=É~ÅÜ=ëÉ~ëçå=çê=ÅóÅäÉ= EÉKÖKI=îÉÖÉJ
í~íáçå=ÅçããìåáíáÉë=åÉÉÇÉÇ=íç=ëìêîáîÉ=
ïáåíÉêëFK= = ^äëç= áåÅäìÇÉ= ~åó= ìåáèìÉ=
îÉÖÉí~íáçå= ÅçããìåáíáÉë= íÜ~í=åÉÉÇ= íç=
ÄÉ= éêçíÉÅíÉÇ= EÉKÖKI= ÄçêÉ~ä= ëï~ãéëI=
çäÇJÖêçïíÜ=ã~ÜçÖ~åó= ëí~åÇëI= ~äéáåÉ=
~êÉ~ëFK= =`çåëáÇÉê=áÑ=ìåáèìÉ=~êÉ~ë=áãJ
éçêí~åí= Ñçê= ã~áåí~áåáåÖ= ä~åÇëÅ~éÉ=
ÅçååÉÅíáîáíó=~êÉ=äáëíÉÇK==fÑ=~=ä~åÇëÅ~éÉ=
ÉäÉãÉåí= áë=åçí=êÉéêÉëÉåíÉÇ=Äó=~åó=çÑ=
íÜÉ= Å~åÇáÇ~íÉ= ëéÉÅáÉëI= íÜÉå= óçì= ïáää=
åÉÉÇ= íç= ~ÇÇ= ~= ëéÉÅáÉë= íÜ~í= ÇçÉë= êÉJ
èìáêÉ=íÜ~í=ÉäÉãÉåíK==klqbW=vçì=ã~ó=
çîÉêäççâ= áãéçêí~åí= ä~åÇëÅ~éÉ= ÉäÉJ
ãÉåíë=áÑ=óçì=ëáãéäó=äáëí=Ü~Äáí~íë=íÜ~í=
~ééÉ~ê= çå= ÉñáëíáåÖ= îÉÖÉí~íáçåI= ä~åÇJ
ìëÉ=çê=ä~åÇ=ÅçîÉê=ã~éëK==================================
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ÄK qÜÉ=j~å~ÖÉãÉåí=wçåÉë=áå=óçìê=ä~åÇëÅ~éÉI=íÜÉ=ëìêJ
Ñ~ÅÉ= ~êÉ~= çÑ= É~ÅÜ= ~åÇ= íÜÉ= äÉîÉä= çÑ= ìëÉ= êÉèìáêÉÇ= íç=
êÉéêÉëÉåí= É~ÅÜ= òçåÉK= = j~åó= ëéÉÅáÉë= ãçîÉ= ~ãçåÖ=
ëÉîÉê~ä=ã~å~ÖÉãÉåí=òçåÉëI=~åÇ=íÜÉêÉÑçêÉ=ÉåÅçìê~ÖÉ=
ìë= ~ë= ÅçåëÉêî~íáçåáëíë= íç= ïçêâ= ïáíÜ= ëÉîÉê~ä= ëí~âÉJ
ÜçäÇÉêë= EÖçîÉêåãÉåí= ~ÖÉåÅáÉëI= áåÇìëíêáÉëI= ÅçããìJ
åáíó= ÖêçìéëI= ÉíÅKF= ~åÇ= íç= ÅççêÇáå~íÉ= ã~å~ÖÉãÉåí=
~Åêçëë=ÄçìåÇ~êáÉëK==aáÑÑÉêÉåÅÉë=áå=ã~å~ÖÉãÉåí=ã~ó=

 Step 2 - Specify the Parameters for Your Landscape  Box D=

a & b. Enter information for the habitat types and management zones

c. Enter information for the human activities

d. Enter information for the home range definition

e. Enter information for the ecological functions

Level of Use: Landscape species are chosen 
in part for how well they represent habitats.  
You need to specify whether a  level of "use" 
value of 2 or 3 qualifies as representing 
habitats (see the text box for descriptions of 
the Level of Use values). The value remains 
constant across candidate species.  If you 
choose a 3 for a particular habitat type, it will 
be considered "represented" only when a 
candidate species with a value of 3 for that 
habitat is included in the suite of Landscape 
Species.  The default value is 2.

Area: The surface area of each habitat type 
(all in the same units).  If any one of the 
surface areas covered by a habitat type is 
unknown, then leave the Area column blank. 

Habitat/MZ Name: Once you have identified your set of habitat types or 
management zones enter their names, area, and level of use by either (i) typing 
the data into the table or (ii) reading the data from a file (see Data -> Import on the 
software menus figure or the online help). 

Probability of occurrence: Enter a value 
between zero and one.  This indicates the 
degree of uncertainty associated with the 
particular human activity (e.g., if you think 
there is a 25% chance that a dam will be built 
enter a value of 0.25).  Activities with a higher 
Probability of Occurrence are more heavily 
weighted when calculating candidate species' 
Threat Index part of the Vulnerability score.

0 = If it occurs, it will not happen in the next 10 years.
1 = If it occurs, it could happen within 3-10 years.
2 = If it occurs, it could or will happen within 1-3 years
3 = Threat is currently happening - must act immediately 

(Probability of Occurrence must be 1).  

Home range definition: Home ranges can be entered as continuous 
values (in km2), selected from a list of default bins or from a list of 
user-defined bins.  If you have unreliable home range estimates or 
diverse taxa with different techniques for home range estimation, 
then it may be wiser to define home range by binned intervals. 

Ecological Functions: The default set of functions is shown to the left.   You can retain this default set 
if it applies to the candidate species in your landscape or add to or remove functions.  Other examples 
of functions for both terrestrial and marine systems include: Top level predation, Mid Level predation, 
Herbivory (algal control), Habitat construction, Habitat maintenance, Waterhole maintenance, 
Autotrophy, Planktivory, Nutrient redistribution, Prey species, Strong competitor, Scavenger. 

Urgency: Describe how soon a particular 
human activity will occur:

Human Activity: Once you have identified all human activities that have 
major negative impacts on the wildlife or the habitats in your landscape 
enter their descriptions, urgency, and probability of occurrence by either (i) 
typing the data into the table or (ii) reading the data from a file 
(see Data -> Import on the software menus figure or the online help). 

a & b. Enter information for the habitat types and management zones

c. Enter information for the human activities

d. Enter information for the home range definition

e. Enter information for the ecological functions

Level of Use: Landscape species are chosen 
in part for how well they represent habitats.  
You need to specify whether a  level of "use" 
value of 2 or 3 qualifies as representing 
habitats (see the text box for descriptions of 
the Level of Use values). The value remains 
constant across candidate species.  If you 
choose a 3 for a particular habitat type, it will 
be considered "represented" only when a 
candidate species with a value of 3 for that 
habitat is included in the suite of Landscape 
Species.  The default value is 2.

Area: The surface area of each habitat type 
(all in the same units).  If any one of the 
surface areas covered by a habitat type is 
unknown, then leave the Area column blank. 

Habitat/MZ Name: Once you have identified your set of habitat types or 
management zones enter their names, area, and level of use by either (i) typing 
the data into the table or (ii) reading the data from a file (see Data -> Import on the 
software menus figure or the online help). 

Probability of occurrence: Enter a value 
between zero and one.  This indicates the 
degree of uncertainty associated with the 
particular human activity (e.g., if you think 
there is a 25% chance that a dam will be built 
enter a value of 0.25).  Activities with a higher 
Probability of Occurrence are more heavily 
weighted when calculating candidate species' 
Threat Index part of the Vulnerability score.

0 = If it occurs, it will not happen in the next 10 years.
1 = If it occurs, it could happen within 3-10 years.
2 = If it occurs, it could or will happen within 1-3 years
3 = Threat is currently happening - must act immediately 

(Probability of Occurrence must be 1).  

Home range definition: Home ranges can be entered as continuous 
values (in km2), selected from a list of default bins or from a list of 
user-defined bins.  If you have unreliable home range estimates or 
diverse taxa with different techniques for home range estimation, 
then it may be wiser to define home range by binned intervals. 

Ecological Functions: The default set of functions is shown to the left.   You can retain this default set 
if it applies to the candidate species in your landscape or add to or remove functions.  Other examples 
of functions for both terrestrial and marine systems include: Top level predation, Mid Level predation, 
Herbivory (algal control), Habitat construction, Habitat maintenance, Waterhole maintenance, 
Autotrophy, Planktivory, Nutrient redistribution, Prey species, Strong competitor, Scavenger. 

Urgency: Describe how soon a particular 
human activity will occur:

a & b. Enter information for the habitat types and management zones

c. Enter information for the human activities

d. Enter information for the home range definition

e. Enter information for the ecological functions

Level of Use: Landscape species are chosen 
in part for how well they represent habitats.  
You need to specify whether a  level of "use" 
value of 2 or 3 qualifies as representing 
habitats (see the text box for descriptions of 
the Level of Use values). The value remains 
constant across candidate species.  If you 
choose a 3 for a particular habitat type, it will 
be considered "represented" only when a 
candidate species with a value of 3 for that 
habitat is included in the suite of Landscape 
Species.  The default value is 2.

Level of Use: Landscape species are chosen 
in part for how well they represent habitats.  
You need to specify whether a  level of "use" 
value of 2 or 3 qualifies as representing 
habitats (see the text box for descriptions of 
the Level of Use values). The value remains 
constant across candidate species.  If you 
choose a 3 for a particular habitat type, it will 
be considered "represented" only when a 
candidate species with a value of 3 for that 
habitat is included in the suite of Landscape 
Species.  The default value is 2.

Area: The surface area of each habitat type 
(all in the same units).  If any one of the 
surface areas covered by a habitat type is 
unknown, then leave the Area column blank. 

Area: The surface area of each habitat type 
(all in the same units).  If any one of the 
surface areas covered by a habitat type is 
unknown, then leave the Area column blank. 

Habitat/MZ Name: Once you have identified your set of habitat types or 
management zones enter their names, area, and level of use by either (i) typing 
the data into the table or (ii) reading the data from a file (see Data -> Import on the 
software menus figure or the online help). 

Habitat/MZ Name: Once you have identified your set of habitat types or 
management zones enter their names, area, and level of use by either (i) typing 
the data into the table or (ii) reading the data from a file (see Data -> Import on the 
software menus figure or the online help). 

Probability of occurrence: Enter a value 
between zero and one.  This indicates the 
degree of uncertainty associated with the 
particular human activity (e.g., if you think 
there is a 25% chance that a dam will be built 
enter a value of 0.25).  Activities with a higher 
Probability of Occurrence are more heavily 
weighted when calculating candidate species' 
Threat Index part of the Vulnerability score.

Probability of occurrence: Enter a value 
between zero and one.  This indicates the 
degree of uncertainty associated with the 
particular human activity (e.g., if you think 
there is a 25% chance that a dam will be built 
enter a value of 0.25).  Activities with a higher 
Probability of Occurrence are more heavily 
weighted when calculating candidate species' 
Threat Index part of the Vulnerability score.

0 = If it occurs, it will not happen in the next 10 years.
1 = If it occurs, it could happen within 3-10 years.
2 = If it occurs, it could or will happen within 1-3 years
3 = Threat is currently happening - must act immediately 

(Probability of Occurrence must be 1).  

0 = If it occurs, it will not happen in the next 10 years.
1 = If it occurs, it could happen within 3-10 years.
2 = If it occurs, it could or will happen within 1-3 years
3 = Threat is currently happening - must act immediately 

(Probability of Occurrence must be 1).  

Home range definition: Home ranges can be entered as continuous 
values (in km2), selected from a list of default bins or from a list of 
user-defined bins.  If you have unreliable home range estimates or 
diverse taxa with different techniques for home range estimation, 
then it may be wiser to define home range by binned intervals. 

Home range definition: Home ranges can be entered as continuous 
values (in km2), selected from a list of default bins or from a list of 
user-defined bins.  If you have unreliable home range estimates or 
diverse taxa with different techniques for home range estimation, 
then it may be wiser to define home range by binned intervals. 

Ecological Functions: The default set of functions is shown to the left.   You can retain this default set 
if it applies to the candidate species in your landscape or add to or remove functions.  Other examples 
of functions for both terrestrial and marine systems include: Top level predation, Mid Level predation, 
Herbivory (algal control), Habitat construction, Habitat maintenance, Waterhole maintenance, 
Autotrophy, Planktivory, Nutrient redistribution, Prey species, Strong competitor, Scavenger. 

Ecological Functions: The default set of functions is shown to the left.   You can retain this default set 
if it applies to the candidate species in your landscape or add to or remove functions.  Other examples 
of functions for both terrestrial and marine systems include: Top level predation, Mid Level predation, 
Herbivory (algal control), Habitat construction, Habitat maintenance, Waterhole maintenance, 
Autotrophy, Planktivory, Nutrient redistribution, Prey species, Strong competitor, Scavenger. 

Urgency: Describe how soon a particular 
human activity will occur:
Urgency: Describe how soon a particular 
human activity will occur:

Human Activity: Once you have identified all human activities that have 
major negative impacts on the wildlife or the habitats in your landscape 
enter their descriptions, urgency, and probability of occurrence by either (i) 
typing the data into the table or (ii) reading the data from a file 
(see Data -> Import on the software menus figure or the online help). 
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~äëç=Ü~îÉ=ä~êÖÉ=áãé~Åíë=çå=Ü~Äáí~í=èì~äáíó=~åÇ=
ä~åÇëÅ~éÉ= ëíêìÅíìêÉ= EÅçãéçëáíáçåI= ÅçåÑáÖìê~J
íáçåI= ~åÇ= ÅçååÉÅíáîáíóF= íÜ~í= ~êÉ= åçí= ~äï~óë=
Å~éíìêÉÇ=Äó=íÜÉ=Ü~Äáí~í=íóéÉë=ïÉ=äáëí=~åÇ=ïáää=
~ÑÑÉÅí= ÉÅçäçÖáÅ~ä= éêçÅÉëëÉë= ~åÇ= åÉÅÉëëáí~íÉ=
ã~å~ÖÉãÉåí= ~Åêçëë= ã~å~ÖÉãÉåí= òçåÉëK==
tÜÉå= ÉåíÉêáåÖ= íÜÉ= ã~å~ÖÉãÉåí= òçåÉëI= ÅçåJ
ëáÇÉê= íÜÉ= ~êÉ~ë= ïÜÉêÉ= ã~å~ÖÉãÉåí= éê~ÅíáÅÉë=
~êÉ= ëìÄëí~åíá~ääó= ÇáÑÑÉêÉåíI= áåÅäìÇáåÖ= äçÅ~äI=
éêçîáåÅá~äI=å~íáçå~ä=~åÇ=áåíÉêå~íáçå~ä=éçäáíáÅ~ä=
ìåáíëI= éêçíÉÅíÉÇ= ~êÉ~= ÄçìåÇ~êáÉëI= ÑçêÉëí= çê=
ãáåáåÖ=ÅçåÅÉëëáçåëI= ÑáëÜáåÖ=çê=ÜìåíáåÖ=òçåÉëI=
~åÇ=éêáî~íÉ=çê=Åçããìå~ä=ä~åÇëK=

ÅK=qÜÉ=eìã~å=^ÅíáîáíáÉë=íÜ~í=ÉáíÜÉê=ÅìêêÉåíäó=
ÅçåëíáíìíÉ= áãéçêí~åí= íÜêÉ~íë= çê= Ü~îÉ= íÜÉ=
éçíÉåíá~ä= íç= áãé~Åí= óçìê= ä~åÇëÅ~éÉ= ~åÇ=
Å~åÇáÇ~íÉ= ëéÉÅáÉë= áå= íÜÉ= ÑìíìêÉI= íÜÉ=éêçÄJ
~Äáäáíó=íÜ~í=É~ÅÜ=íÜêÉ~í=ïáää=çÅÅìêI=~åÇ=íÜÉ=
ìêÖÉåÅó=çÑ=íÜÉ=íÜêÉ~íK==vçìê=éêçàÉÅí=íÉ~ã=
Å~å=ÇÉÑáåÉ= íÜÉ=âÉó= íÜêÉ~íë=çê=óçì=Å~å=çêJ
Ö~åáòÉ=~=ãçêÉ=Ñçêã~ä=é~êíáÅáé~íçêó=ëé~íá~ä=
~ëëÉëëãÉåí=çÑ=Üìã~å=~ÅíáîáíáÉë= íç=Çç= íÜáë=
EëÉÉ= qÉÅÜåáÅ~ä= j~åì~ä= N= áå= íÜáë= ëÉêáÉëFK==
`çåëáÇÉê= ~ää= Üìã~å= ~ÅíáîáíáÉë= íÜ~í= Ü~îÉ=
ã~àçê=åÉÖ~íáîÉ= áãé~Åíë=çåW= ENF= áåÇáîáÇì~ä=
Å~åÇáÇ~íÉ= ëéÉÅáÉë= EÉKÖKI=éç~ÅÜáåÖFX= EOF= íÜÉ=
Ü~Äáí~í= íóéÉë= óçì=Ü~îÉ= äáëíÉÇ= EÉKÖKI= Çê~áåJ
áåÖ= çÑ= ïÉíä~åÇëFX= EPF= íÜÉ= ÉÅçäçÖáÅ~ä= éêçJ
ÇìÅíáîáíó=çÑ= íÜÉ= ä~åÇëÅ~éÉ= EÉKÖKI=çîÉêÖê~òJ
áåÖ=çÑ=Öê~ëëä~åÇ=Äó=äáîÉëíçÅâFX=EQF=íÜÉ=ëé~J
íá~ä= áåíÉÖêáíó= çÑ= íÜÉ= ä~åÇëÅ~éÉ= EÉKÖKI= Ñê~ÖJ
ãÉåí~íáçåFX= çê= ERF= íÜÉ= ïáäÇ= ÅÜ~ê~ÅíÉê= çÑ=
íÜÉ=ä~åÇëÅ~éÉ=EÉKÖKI=ëÉÅçåÇ=ÜçãÉ=ÇÉîÉäçéJ
ãÉåíFK===

ÇK= qÜÉ= ãÉíÜçÇ= Ñçê= ëéÉÅáÑóáåÖ=eçãÉ= o~åÖÉ=
ëáòÉK=

ÉK= qÜÉ= bÅçäçÖáÅ~ä= cìåÅíáçåë= íÜ~í= çÅÅìê= áå=
óçìê=ä~åÇëÅ~éÉK=

=
pÉÉ= _çñ= a= Ñçê= ãçêÉ= ÇÉí~áä= çå= íÜÉ= ëÉäÉÅíáçå=
ëçÑíï~êÉ= çéíáçåë= Ñçê= íÜÉ= ~ÄçîÉ= çê= _çñ= f= Ñçê=
~å= Éñ~ãéäÉ= çÑ= Üçï= íÜÉ= Ü~Äáí~í= íóéÉë= ~åÇ=
íÜêÉ~íë= ïÉêÉ= ÇÉÑáåÉÇ= Ñçê= íÜÉ= k~ã= h~ÇáåÖ=
i~åÇëÅ~éÉI=i~ç=maoK 

Level of Use 
 

 

Value = 0: The population of the candidate species does not use the habitat type or management zone.  Either the spe-
cies is never seen there, or only an occasional dispersing or exploring animal is seen. 

Value = 1: The population of the candidate species uses the habitat type or management zone, but the persistence and 
abundance of the species is unlikely to be heavily impacted by reduction in the extent, quality or access to the habitat 
type or management zone.  The species can easily compensate for such reductions by using a different habitat or zone.  
For instance, the habitat, along with several others, is used for movement between other habitats, but the species is not 
dependent on the specific habitat for movement. 

Value = 2: The population of the candidate species is strongly dependent on the habitat type or management zone, al-
though the population does not require it to persist in the landscape.  Reduction in the extent, quality, or access to the 
habitat or zone will have significant impacts on the abundance and distribution of the candidate species in the land-
scape, although loss of the habitat is unlikely to cause local extinction.  If observations of the species indicate that it 
spends a lot of time in a habitat or management zone, but it is unclear whether it technically "requires" it, this value is 
an appropriate choice. 

Value = 3: The population of the candidate species requires the habitat type or management zone to fulfill its life cycle.  
If the habitat or management zone were to disappear from the landscape, so would the candidate species.  If the habi-
tat or management zone is destroyed, the species will go locally extinct.  For instance, the presence of many bird species 
is tied directly to the presence of a particular nesting habitat.   
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Step 3: Enter values for the 
 5 selection criteria for 
 each candidate species 
 

qç= Å~äÅìä~íÉ= ~= ëÅçêÉ= Ñçê= É~ÅÜ= ëéÉÅáÉë= áå=
íÉêãë=çÑ= íÜÉ=R= ëÉäÉÅíáçå= ÅêáíÉêá~= ÅçãéäÉíÉ=
íÜÉ=ÑçääçïáåÖ=ëíÉéë=EëÉÉ=_çñ=bFW=
~K= = cçê= íÜÉ=eÉíÉêçÖÉåÉáíó= ÅêáíÉêáçå= ÉåíÉê=

iÉîÉä=çÑ=rëÉ=Ç~í~=íÜ~í=ÇÉÑáåÉ=Üçï=É~ÅÜ=
Å~åÇáÇ~íÉ= ëéÉÅáÉë= ìëÉë= íÜÉ= Ü~Äáí~í=
íóéÉë=~åÇ=ã~å~ÖÉãÉåí=òçåÉëK==péÉÅáÉë=
íÜ~í= êÉéêÉëÉåí=ãçêÉ=Ü~Äáí~í= íóéÉë= ~åÇ=
ã~å~ÖÉãÉåí= òçåÉë= ïáää= êÉÅÉáîÉ= ~=
ÜáÖÜÉê= íçí~ä= ëÅçêÉ= Ñçê= ÜÉíÉêçÖÉåÉáíó=
~åÇ= Ü~îÉ= ~= ÄÉííÉê= ÅÜ~åÅÉ= çÑ= ÖÉííáåÖ=
ëÉäÉÅíÉÇK==_ó=Ñ~îçêáåÖ=ëìÅÜ=ëéÉÅáÉëI=ïÉ=
êÉÇìÅÉ=íÜÉ=åìãÄÉê=çÑ=íçí~ä=ëéÉÅáÉë=íÜ~í=
~êÉ= åÉÉÇÉÇ= íç= ÅçãéäÉíÉ= íÜÉ= ëìáíÉ= Äó=
áåÅêÉ~ëáåÖ=áíë=ÉÑÑáÅáÉåÅóK= =^ÇÇáíáçå~ääóI=
Äó= Ñ~îçêáåÖ= ëéÉÅáÉë= íÜ~í= ÇÉéÉåÇ= çå=
~åÇ= ãçîÉ= ~ãçåÖ= ëÉîÉê~ä= ÇáÑÑÉêÉåí=
Ü~Äáí~íë= ~åÇ= ã~å~ÖÉãÉåí= òçåÉëI= ïÉ=
ÜÉäé=ÉåëìêÉ=íÜ~í=íÜÉ=ÅçãéçëáíáçåI=ÅçåJ
ÑáÖìê~íáçåI= ~åÇ= ÅçååÉÅíáîáíó= çÑ= ä~åÇJ
ëÅ~éÉ=ÉäÉãÉåíë=áë=ã~áåí~áåÉÇK=

ÄK=qç= ÇÉÑáåÉ= É~ÅÜ= ëéÉÅáÉëÛ=^êÉ~= oÉèìáêÉJ
ãÉåíë= ÉåíÉê= Ç~í~= Ñçê= ENF= áíë= ÜçãÉ=
ê~åÖÉ=ëáòÉX=EOF= áíë=íÉåÇÉåÅó=íç=ÇáëéÉêëÉ=
çîÉê= ä~êÖÉ= Çáëí~åÅÉëX= EPF= íÜÉ= éêçéçêJ
íáçå= çÑ= íÜÉ= ä~åÇëÅ~éÉ= áí= çÅÅìéáÉëX= ~åÇ=
EQF= íÜÉ= áãéçêí~åÅÉ= çÑ= Ü~Äáí~í= ÅçååÉÅJ
íáîáíó= Ñçê= íÜ~í= ëéÉÅáÉëK= = qÜáë= ÅêáíÉêáçå=
Ñ~îçêë= ïáÇÉJê~åÖáåÖ= ëéÉÅáÉë= ïáíÜ= ÉñJ
íÉåëáîÉ=~êÉ~=êÉèìáêÉãÉåíëI=ïÜáÅÜ=ÜÉäéë=
ÉåëìêÉ= íÜ~í= íÜÉ= ä~åÇëÅ~éÉ= áë= ëìÑÑáJ
ÅáÉåíäó= ä~êÖÉ= ~åÇ= ïÉää= ÅçååÉÅíÉÇ= íç=
ëìééçêí=ãçëí=ÄáçÇáîÉêëáíóK=

ÅK= cçê= íÜÉ= sìäåÉê~Äáäáíó= ÅêáíÉêáçå= ÉåíÉê=
áåÑçêã~íáçå= çå= íÜÉ= `ìêêÉåí= `çåëÉêî~J
íáçå= pí~íìë= E``pF= çÑ= É~ÅÜ= Å~åÇáÇ~íÉ=
ëéÉÅáÉë= EëÉÉ= _çñ=bF= ~åÇ= Ç~í~= íç= Å~äÅìJ
ä~íÉ=íÜÉ=qÜêÉ~í=fåÇÉñK==``p=áë=~=îçäìåJ
í~êó=î~êá~ÄäÉ= íÜ~í=Å~å=ÄÉ=ìëÉÇ=íç=Ñ~îçê=
ëéÉÅáÉë= áå= áããÉÇá~íÉ= Ç~åÖÉê= çÑ= äçÅ~ä=
ÉñíáåÅíáçåI= ïÜÉêÉ= å~íìê~ääó= çÅÅìêêáåÖ=
ëíçÅÜ~ëíáÅ= ÉÑÑÉÅíë= ÅçìäÇ= Å~ìëÉ= íÜÉáê= ÉñJ
íáåÅíáçåK==pçãÉ=éêçàÉÅíë=ã~ó=ÅÜççëÉ=íç=
Ñ~îçê= íÜÉëÉ= ëéÉÅáÉë= êÉä~íáîÉ= íç= ëéÉÅáÉë=
íÜ~í=~êÉ=åçí=áå=áããÉÇá~íÉ=Ç~åÖÉê=çÑ=ÉñJ
íáåÅíáçåK==líÜÉêë=ã~ó=ÅÜççëÉ=åçí=íç=ìëÉ=
íÜáë= î~êá~ÄäÉI= ÄÉÅ~ìëÉ= íÜÉó= ~êÉ= Éèì~ääó=

 

çê=ãçêÉ= ÅçåÅÉêåÉÇ= ~Äçìí= ëéÉÅáÉë= íÜ~í= ~êÉ= çìíëáÇÉ=
çÑ=íÜáë=áããÉÇá~íÉ=“Ç~åÖÉê=òçåÉÒK==péÉÅáÉë=íÜ~í=~êÉ=
åçí=áå=áããÉÇá~íÉ=Ç~åÖÉê=çÑ=ÉñíáåÅíáçåI=~êÉ=åçí=ÇÉJ
ÅäáåáåÖI= ~åÇ= ~êÉ= åçí= äáâÉäó= íç= ÇÉÅäáåÉ= ëáÖåáÑáÅ~åíäó=
áå= íÜÉ= ÑçêÉëÉÉ~ÄäÉ= ÑìíìêÉ= éêçÄ~Ääó= ëÜçìäÇ= åçí= ÄÉ=
çå=íÜÉ=Å~åÇáÇ~íÉ=ëéÉÅáÉë=äáëí=áå=íÜÉ=Ñáêëí=éä~ÅÉK==``p=
áë= ê~íÉÇ= çå= ~= ëÅ~äÉ= çÑ= MJNI= ïÜÉêÉ= ~= î~äìÉ= çÑ= M=
ãÉ~åë= íÜ~í= íÜÉ= éçéìä~íáçå= çÑ= íÜÉ= ëéÉÅáÉë= áå= íÜÉ=
ä~åÇëÅ~éÉ= áë= ëÉîÉêÉäó= ÇÉéäÉíÉÇ= ~åÇ= áå= áããÉÇá~íÉ=
Ç~åÖÉê= çÑ= ÖçáåÖ= äçÅ~ääó= ÉñíáåÅíK= = lå= íÜÉ= çíÜÉê=
Ü~åÇI= ~= î~äìÉ= çÑ= N=ãÉ~åë= íÜ~í= íÜÉ= éçéìä~íáçå= çÑ=
íÜÉ=ëéÉÅáÉë=áå=íÜÉ=ä~åÇëÅ~éÉ=áë=áå=åç=é~êíáÅìä~ê=Ç~åJ
ÖÉê= çÑ= ÄÉáåÖ= Éñíáêé~íÉÇ= äçÅ~ääó= áå= íÜÉ= ÑçêÉëÉÉ~ÄäÉ=
ÑìíìêÉI= Äìí= áíë= éçéìä~íáçå= áë= ÇÉÅäáåáåÖ=çê=ã~ó=ÇÉJ
ÅäáåÉ= ëáÖåáÑáÅ~åíäó= ïáíÜáå= óçìê= éä~ååáåÖ= Üçêáòçå=
ÇìÉ=íç=Üìã~å=~ÅíáîáíáÉëK==^Ö~áåI=íÜÉ=î~êá~ÄäÉ=áë=îçäJ
ìåí~êó=J=áÑ=óçì=Çç=åçí=ï~åí=íÜÉ=``p=íç=~ÑÑÉÅí=íÜÉ=
ëÉäÉÅíáçå= çÑ= ëéÉÅáÉëI= ëáãéäó= äÉ~îÉ= íÜÉ= î~äìÉ= Ñçê=
ÉîÉêó=ëéÉÅáÉë=~í=áíë=ÇÉÑ~ìäí=î~äìÉ=çÑ=NK==qÜÉ=qÜêÉ~í=
fåÇÉñ= áë=ÇÉëáÖåÉÇ= íç= Ñ~îçê= íÜÉ= ëÉäÉÅíáçå=çÑ= ëéÉÅáÉë=
íÜ~í= ~êÉ= ÅìêêÉåíäó= ÄÉáåÖI= çê= ~êÉ= äáâÉäó= íç= ÄÉI= áãJ
é~ÅíÉÇ=Äó=ã~åó=íÜêÉ~íëX=çê=íÜçëÉ=ëÉîÉêÉäó=áãé~ÅíÉÇ=
Äó=~=ÑÉï=íÜêÉ~íë=Eçê=ÄçíÜFK= =_ó=Ñ~îçêáåÖ=ëìÅÜ=ëéÉJ
ÅáÉëI=ïÉ=êÉÇìÅÉ=íÜÉ=åìãÄÉê=çÑ=íçí~ä=ëéÉÅáÉë=íÜ~í=~êÉ=
åÉÉÇÉÇ= íç= ÅçãéäÉíÉ= íÜÉ= ëìáíÉI= íÜìë= áåÅêÉ~ëáåÖ= áíë=
ÉÑÑáÅáÉåÅóK= = tÉ= ~äëç= Ñ~îçê= ëéÉÅáÉë= íÜ~í= ~êÉ= ãçêÉ=
îìäåÉê~ÄäÉ=íç=Üìã~å=~ÅíáîáíáÉëI=áå=íÉêãë=çÑ=éçéìä~J
íáçå= ÇÉÅäáåÉ= çê= Éñíáêé~íáçåK= = qÜÉ= ÉÑÑÉÅí= çÑ= É~ÅÜ=
íÜêÉ~í= Ñçê=~= Å~åÇáÇ~íÉ= ëéÉÅáÉë= áë=ÖáîÉå=~=î~äìÉ=~ÅJ
ÅçêÇáåÖ=íç=áíë=ëÉîÉêáíó=EpFI=Üçï=èìáÅâäó=íÜÉ=ëéÉÅáÉë=
Å~å= êÉÅçîÉê= EoF= áÑ= íÜÉ= íÜêÉ~í= ïÉêÉ= êÉãçîÉÇI= ~åÇ=
íÜÉ= éêçéçêíáçå= çÑ= íÜÉ= ëéÉÅáÉëÛ= äçÅ~ä= ÇáëíêáÄìíáçå=
~ÑÑÉÅíÉÇ= Em~F= Äó= íÜÉ= íÜêÉ~íK= = ^ÇÇáíáçå~ääóI= íÜêÉ~íë=
íÜ~í=~êÉ=ãçêÉ=ìêÖÉåí=~åÇ=íÜ~í=~ÑÑÉÅí=~= ä~êÖÉê=éêçJ
éçêíáçå=çÑ=íÜÉ=ÉåíáêÉ=ä~åÇëÅ~éÉ=~êÉ=ïÉáÖÜíÉÇ=ãçêÉ=
ÜÉ~îáäó= ïÜÉå= Å~äÅìä~íáåÖ= íÜÉ= qÜêÉ~í= fåÇÉñ= EëÉÉ=
píÉé=QFK=

Candidate species’ local 
distribution in the landscape.
Candidate species’ local 
distribution in the landscape.

LandscapeLandscape

Proportion of a species' local 
distribution affected currently 
or in future by a particular 
threat (Pa). The threat’s 
severity (S) can have impacts 
beyond this area of the 
landscape (mortality sinks).

Proportion of a species' local 
distribution affected currently 
or in future by a particular 
threat (Pa). The threat’s 
severity (S) can have impacts 
beyond this area of the 
landscape (mortality sinks).

Proportion of Area Affected Pa



Living Landscapes Program—Landscape Species Selection Software wildlife conservation society  9 

ÇK=båíÉê=î~äìÉë=Ñçê=íÜÉ=bÅçäçÖáÅ~ä=cìåÅíáçå~äáíó=ÅêáJ
íÉêáçå= Ä~ëÉÇ= çå= Üçï= É~ÅÜ= Å~åÇáÇ~íÉ= ëéÉÅáÉë= ÑìäJ
Ñáääë= íÜÉ= ÉÅçäçÖáÅ~ä= ÑìåÅíáçåë= áå= íÜÉ= ä~åÇëÅ~éÉK==
pçãÉ= ëéÉÅáÉë= Ü~îÉ= é~êíáÅìä~êäó= ëíêçåÖ= ÉÑÑÉÅíë= çå=
íÜÉ=ëíêìÅíìêÉ=~åÇ=ÑìåÅíáçå=çÑ=å~íìê~ä=ÉÅçëóëíÉãëK==
_É~îÉêë=ÅêÉ~íÉ=ïÉíä~åÇë=Äó=Ç~ããáåÖ=êáîÉêëI=í~éáê=
~åÇ= ÉäÉéÜ~åíë= ÇáëéÉêëÉ= ëÉÉÇë= ~åÇ= íÜáå= íÜÉ= ÑçêÉëí=
ìåÇÉêëíçêóI= ~åÇ= íçé= éêÉÇ~íçêë= Å~å= Åçåíêçä= íÜÉ=
~ÄìåÇ~åÅÉ=~åÇ=Åçãéçëáíáçå=çÑ=éêÉó=ÅçããìåáíáÉëK==
bÅçäçÖáÅ~ääó= éáîçí~ä= ëéÉÅáÉë= ã~ó= ÜÉäé= ÅçåëÉêîÉ=
ÜÉ~äíÜó= ÅçããìåáíáÉë= ~åÇ= ÉÅçëóëíÉãëI= íÜìë= ÉÅçJ
äçÖáÅ~ä= ÑìåÅíáçå~äáíó= áë= çåÉ= çÑ= íÜÉ= ÑáîÉ= ëÉäÉÅíáçå=
ÅêáíÉêá~=ìëÉÇ=áå=ê~åâáåÖ=íÜÉ=ëéÉÅáÉëK===

ÉK=båíÉê=î~äìÉë=Ñçê=íÜÉ=pçÅáçJÉÅçåçãáÅ=páÖåáÑáÅ~åÅÉ=
ÅêáíÉêáçå= Ä~ëÉÇ= çå= É~ÅÜ= Å~åÇáÇ~íÉ= ëéÉÅáÉëÛ= ëí~íìë=
~ë= ~= Ñä~ÖëÜáé= ëéÉÅáÉëI= áíë= Åìäíìê~ä= î~äìÉI= ~åÇ= áíë=
ÉÅçåçãáÅ=î~äìÉK==qÜáë=ÅêáíÉêáçå=Éñáëíë=ÄÉÅ~ìëÉ=ëçJ
Åá~ä= ÉåîáêçåãÉåí= Å~å= Çê~ëíáÅ~ääó= ~ÑÑÉÅí= ÅçåëÉêî~J
íáçå= çìíÅçãÉëK= = táäÇäáÑÉ= ã~ó= Åä~ëÜ= ïáíÜ= éÉçéäÉ=
~åÇ= ÄÉ= éÉêÅÉáîÉÇ= åÉÖ~íáîÉäó= áÑ= íÜÉó= ê~áÇ= ÅêçéëI=

éêÉó= çå= äáîÉëíçÅâI= íê~åëãáí= ÇáëÉ~ëÉë= íç=
ÇçãÉëíáÅ=~åáã~äë=çê=éÉçéäÉI=çê=ÅçãéÉíÉ=
Ñçê= êÉëçìêÅÉëK= = táäÇäáÑÉ= ã~ó= ÄÉ= éÉêJ
ÅÉáîÉÇ= éçëáíáîÉäó= áÑ= íÜÉó= Ü~îÉ= ÄÉåÉÑáíëI=
ëìÅÜ=~ë=ëÉêîáåÖ=~ë=~=Åìäíìê~ä=áÅçå=çê=íçJ
íÉãI= ÑçêãáåÖ= ~= ëáÖåáÑáÅ~åí= éçêíáçå= çÑ=
éÉçéäÉDë=ÇáÉíëI=çê=éêçîáÇáåÖ=çééçêíìåáJ
íáÉë=Ñçê=áåÅçãÉK==

ÑK=fÑ=óçì=ï~åí=íç=âÉÉé=íê~Åâ=çÑ=óçìê=Ç~í~=
èì~äáíóI= íÜÉå= ëÉäÉÅí= ~= î~äìÉ= Ñêçã= íÜÉ=
a~í~= nì~äáíó= Çêçé= Ççïå= äáëíI= ~ë= óçì=
ÉåíÉê= Ç~í~= Ñçê= É~ÅÜ= Å~åÇáÇ~íÉ= ëéÉÅáÉëK==
fí= áë=åçí=ã~åÇ~íçêó=íÜ~í=óçì=ÉåíÉê=íÜáë=
Ç~í~=~åÇ=áí=ÇçÉë=åçí=áåÑäìÉåÅÉ=íÜÉ=ëÉäÉÅJ
íáçå= éêçÅÉëëK= = eçïÉîÉêI= áí= ÇçÉë= Ü~îÉ=
ÅÉêí~áå= ~Çî~åí~ÖÉëI= å~ãÉäóW= ENF= áí= ïáää=
ã~áåí~áå= íê~åëé~êÉåÅó= ~åÇ= äÉí= çíÜÉêë=
~ééê~áëÉ= íÜÉ=î~äáÇáíó=çÑ=óçìê=ÇÉÅáëáçåëX=
~åÇ=EOF=áí=ïáää=éêçîáÇÉ=~å=áåÇÉñ=Ñçê=ëÉíJ
íáåÖ=êÉëÉ~êÅÜ=éêáçêáíáÉëK==

 Step 3 - Enter Values for the 5 Selection Criteria for Each Candidate Species Box E 

Select the current candidate species for data 
entry from the drop-down list.

The quality of each species' data used for the 5 criteria can be coded as: 
1 = Excellent data from the site.
2 = Excellent data from an ecologically similar site.
3 = Good data from the site or an ecologically similar one.
4 = Bad or incomplete data from the site or a similar ecosystem.
5 = Data only available for a similar species or ecologically dissimilar site.
6 = No data - informed guesses based on sister taxa, allometry, etc.

Enter level of use
values (see text 
box for options & 
definitions) for 
each habitat and 
management 
zone.

How strong a role a species plays in fulfilling each 
of the listed ecological functions can be defined 
by selecting a value from the drop-down list:
0 =  Species plays no role in the function.
1 =  Species has a suspected or weak effect.
2 =  Species has a clear effect.
3 =  Species has a strong effect.

Each species status as a flagship 
species, its cultural value, and its 
economic value act as proxies for its 
Socio-economic Significance. For 
each proxy, values can be selected 
from a drop-down list as follows:
0 =  Species has no significance.
1 =  Species has some significance. 
2 =  Species has great significance.

The area requirements of a 
species are defined by entering 
data to specify its home range 
size, its tendency to disperse 
large distances, the proportion of 
the habitat types used by the 
population and by whether 
connectivity is important for that 
species.

A species’ Vulnerability is defined in terms of its Current 
Conservation Status and its Threat Index. The latter is 
calculated by considering the implications of each human 
activity (potential threat) for the species in terms of:
1. the severity (S) of its effect on the species,
2. the time required to recover from the threat (R), and 
3. the proportion of the candidate species' local distribution 

affected (Pa) by the potential threat. 

1. Severity (S): The degree to which a particular 
threat decreases the abundance and local 
distribution of the species (either within or outside 
its area of occurrence, e.g. by creating a mortality 
sink). Severity is defined by selecting one of the 
following values from the drop-down list:
0 = none or positive
1 = little - measurable but small effect on 

density or distribution.
2 = some - substantial effect on density or

distribution, local eradication unlikely.
3 = serious - local eradication a possibility.

2. Recovery time (R): How quickly the 
population can recover from the 
impacts of a particular threat (given 
that the threat is or will occur) were it 
removed.  Recovery time is defined by 
selecting one of the following values 
from the drop-down list:
0 = Immediate or less than 1 year.
1 = Recovery within 1-10 years.
2 = Recovery within 10-100 years.
3 = Recovery would take more than

100 years or never occur.

3. Proportion of area affected (Pa): Estimated 
proportion of the species' local distribution (in 
the landscape) within which a particular threat 
occurs (see Figure). Proportion affected is 
defined by selecting one of the following values 
from the drop-down list:
0 = None of the local distribution affected.
1 = < 10% of the local distribution affected.
2 = 10% – 25% of the local distribution affected.
3 = 25% – 50% of the local distribution affected.
4 = More than half of the local distribution 

affected.

Select the current candidate species for data 
entry from the drop-down list.

The quality of each species' data used for the 5 criteria can be coded as: 
1 = Excellent data from the site.
2 = Excellent data from an ecologically similar site.
3 = Good data from the site or an ecologically similar one.
4 = Bad or incomplete data from the site or a similar ecosystem.
5 = Data only available for a similar species or ecologically dissimilar site.
6 = No data - informed guesses based on sister taxa, allometry, etc.

The quality of each species' data used for the 5 criteria can be coded as: 
1 = Excellent data from the site.
2 = Excellent data from an ecologically similar site.
3 = Good data from the site or an ecologically similar one.
4 = Bad or incomplete data from the site or a similar ecosystem.
5 = Data only available for a similar species or ecologically dissimilar site.
6 = No data - informed guesses based on sister taxa, allometry, etc.

Enter level of use
values (see text 
box for options & 
definitions) for 
each habitat and 
management 
zone.
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management 
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of the listed ecological functions can be defined 
by selecting a value from the drop-down list:
0 =  Species plays no role in the function.
1 =  Species has a suspected or weak effect.
2 =  Species has a clear effect.
3 =  Species has a strong effect.
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of the listed ecological functions can be defined 
by selecting a value from the drop-down list:
0 =  Species plays no role in the function.
1 =  Species has a suspected or weak effect.
2 =  Species has a clear effect.
3 =  Species has a strong effect.

Each species status as a flagship 
species, its cultural value, and its 
economic value act as proxies for its 
Socio-economic Significance. For 
each proxy, values can be selected 
from a drop-down list as follows:
0 =  Species has no significance.
1 =  Species has some significance. 
2 =  Species has great significance.

Each species status as a flagship 
species, its cultural value, and its 
economic value act as proxies for its 
Socio-economic Significance. For 
each proxy, values can be selected 
from a drop-down list as follows:
0 =  Species has no significance.
1 =  Species has some significance. 
2 =  Species has great significance.

The area requirements of a 
species are defined by entering 
data to specify its home range 
size, its tendency to disperse 
large distances, the proportion of 
the habitat types used by the 
population and by whether 
connectivity is important for that 
species.

The area requirements of a 
species are defined by entering 
data to specify its home range 
size, its tendency to disperse 
large distances, the proportion of 
the habitat types used by the 
population and by whether 
connectivity is important for that 
species.

A species’ Vulnerability is defined in terms of its Current 
Conservation Status and its Threat Index. The latter is 
calculated by considering the implications of each human 
activity (potential threat) for the species in terms of:
1. the severity (S) of its effect on the species,
2. the time required to recover from the threat (R), and 
3. the proportion of the candidate species' local distribution 

affected (Pa) by the potential threat. 

A species’ Vulnerability is defined in terms of its Current 
Conservation Status and its Threat Index. The latter is 
calculated by considering the implications of each human 
activity (potential threat) for the species in terms of:
1. the severity (S) of its effect on the species,
2. the time required to recover from the threat (R), and 
3. the proportion of the candidate species' local distribution 

affected (Pa) by the potential threat. 

1. Severity (S): The degree to which a particular 
threat decreases the abundance and local 
distribution of the species (either within or outside 
its area of occurrence, e.g. by creating a mortality 
sink). Severity is defined by selecting one of the 
following values from the drop-down list:
0 = none or positive
1 = little - measurable but small effect on 

density or distribution.
2 = some - substantial effect on density or

distribution, local eradication unlikely.
3 = serious - local eradication a possibility.

1. Severity (S): The degree to which a particular 
threat decreases the abundance and local 
distribution of the species (either within or outside 
its area of occurrence, e.g. by creating a mortality 
sink). Severity is defined by selecting one of the 
following values from the drop-down list:
0 = none or positive
1 = little - measurable but small effect on 

density or distribution.
2 = some - substantial effect on density or

distribution, local eradication unlikely.
3 = serious - local eradication a possibility.

2. Recovery time (R): How quickly the 
population can recover from the 
impacts of a particular threat (given 
that the threat is or will occur) were it 
removed.  Recovery time is defined by 
selecting one of the following values 
from the drop-down list:
0 = Immediate or less than 1 year.
1 = Recovery within 1-10 years.
2 = Recovery within 10-100 years.
3 = Recovery would take more than

100 years or never occur.

2. Recovery time (R): How quickly the 
population can recover from the 
impacts of a particular threat (given 
that the threat is or will occur) were it 
removed.  Recovery time is defined by 
selecting one of the following values 
from the drop-down list:
0 = Immediate or less than 1 year.
1 = Recovery within 1-10 years.
2 = Recovery within 10-100 years.
3 = Recovery would take more than

100 years or never occur.

3. Proportion of area affected (Pa): Estimated 
proportion of the species' local distribution (in 
the landscape) within which a particular threat 
occurs (see Figure). Proportion affected is 
defined by selecting one of the following values 
from the drop-down list:
0 = None of the local distribution affected.
1 = < 10% of the local distribution affected.
2 = 10% – 25% of the local distribution affected.
3 = 25% – 50% of the local distribution affected.
4 = More than half of the local distribution 

affected.

3. Proportion of area affected (Pa): Estimated 
proportion of the species' local distribution (in 
the landscape) within which a particular threat 
occurs (see Figure). Proportion affected is 
defined by selecting one of the following values 
from the drop-down list:
0 = None of the local distribution affected.
1 = < 10% of the local distribution affected.
2 = 10% – 25% of the local distribution affected.
3 = 25% – 50% of the local distribution affected.
4 = More than half of the local distribution 

affected.
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Å~å= Åçåíê~ëí= íÜÉ= qÜêÉ~í= fåÇÉñ= Ñçê= ë~ãÄ~ê= ~åÇ=
ïáäÇ=éáÖ=Ñçê= ÚeìåíáåÖ=Ñçê=íê~ÇÉ=~ë=ÑççÇÛK= fåáíá~ääó=
áí= ã~ó= ÄÉ= ëìêéêáëáåÖ= íÜ~í= íÜÉ= áåÇÉñ= áë= ä~êÖÉê= Ñçê=
ë~ãÄ~êI=Äìí=íÜáë=ã~âÉë=ëÉåëÉ=ÖáîÉå=íÜÉ=ïáäÇ=éáÖÛë=
êÉéêçÇìÅíáîÉ=Å~é~Åáíó=~åÇ=Ñ~ëíÉê=êÉÅçîÉêó=íáãÉFK==
=

b. Review the summary graphs 
qÜÉ= ë~ãÉ= áåÑçêã~íáçå=éêçîáÇÉÇ= áå= íÜÉ=pìãã~êó=
q~ÄäÉë=áë=~äëç=Çáëéä~óÉÇ=Öê~éÜáÅ~ääó=ÉáíÜÉê=Äó=ëéÉJ
ÅáÉë= çê= Äó= Ü~Äáí~íI= ã~å~ÖÉãÉåí= òçåÉ= çê= íÜêÉ~í=
EëÉÉ=_çñ=dFK=
=

c. Review the criterion/aggregate scores 
låÅÉ= óçì= Ü~îÉ= ÉåíÉêÉÇ= ~ää= íÜÉ= Ç~í~I= îáÉï= ÉáíÜÉê=
íÜÉ= ê~ï= çê= åçêã~äáòÉÇ= ÜÉíÉêçÖÉåÉáíóI= ~êÉ~= êÉJ
èìáêÉãÉåíëI= îìäåÉê~ÄáäáíóI= ÉÅçäçÖáÅ~ä= ÑìåÅíáçå~äJ
áíóI= ëçÅáçJÉÅçåçãáÅ= ëáÖåáÑáÅ~åÅÉ= ~åÇ= ~ÖÖêÉÖ~íÉ=

Step 4: Examine and refine your 
species selection data=

 

a. Review the summary tables 
`äáÅâ= íÜÉ= ëìÄJí~Äë= ìåÇÉê= íÜÉ=pìãã~êó= q~J
ÄäÉë= í~Ä= íç= ÖÉí= ~å= çîÉêîáÉï= çÑ= ~ää= íÜÉ= Ç~í~=
ÉåíÉêÉÇ= Ñçê= íÜÉ= Å~åÇáÇ~íÉ= ëéÉÅáÉë= ìåÇÉê= íÜÉ=
ÑáîÉ= ëÉäÉÅíáçå= ÅêáíÉêá~K= = bñéäçêÉ= íÜÉëÉ= í~ÄäÉë=
íç= ÅäçëÉäó= Éñ~ãáåÉ= ~åÇ= êÉîáëÉ= óçìê= Ç~í~K==
a~í~= Å~å= ÄÉ= ÉÇáíÉÇ= áå= ÅÉêí~áå= ëìãã~êó= í~J
ÄäÉë= áåëíÉ~Ç= çÑ= êÉíìêåáåÖ= íç= íÜÉ= pÉäÉÅíáçå=
`êáíÉêá~= í~ÄK= = jçëí= çÑ= íÜÉ= í~ÄäÉë= éêçîáÇÉ=
ëáãéäÉ= çîÉêîáÉïë= çÑ= íÜÉ= éêÉîáçìëäó= ÉåíÉêÉÇ=
Ç~í~I=ïÜÉêÉ~ë=íÜÉ=eÉíÉêçÖÉåÉáíó=~åÇ=sìäåÉêJ
~Äáäáíó= í~ÄäÉë= éêçîáÇÉ= ~ÇÇáíáçå~ä= áåÑçêã~J
íáçåK= = qÜÉ= ÑçêãÉê= Çáëéä~óë= Å~äÅìä~íÉÇ= íçí~äë=
çÑ= Üçï=ã~åó=Ü~Äáí~í= íóéÉë= çê=ã~å~ÖÉãÉåí=
òçåÉë=~êÉ=ìëÉÇ=Äó=É~ÅÜ=çÑ=íÜÉ=Å~åÇáÇ~íÉ=ëéÉJ
ÅáÉëI=Üçï=ã~åó=ëéÉÅáÉë=ìëÉ=~=é~êíáÅìä~ê=Ü~ÄáJ
í~í= íóéÉI= ~åÇ= ~ÖÖêÉÖ~íÉ= äÉîÉä= çÑ= ìëÉ= Äó= ëéÉJ
ÅáÉëLÜ~Äáí~íK= =qÜÉ= ä~ííÉê=Çáëéä~óë= íÜêÉ~í= áåÇáJ
ÅÉë= Ñçê= É~ÅÜ= ëéÉÅáÉëJíÜêÉ~í= ÅçãÄáå~íáçåI= íçJ
í~äë= ~åÇ= ~ÖÖêÉÖ~íÉ= íÜêÉ~í= áåÇáÅÉë= ÄçíÜ= Äó=
ëéÉÅáÉë=~åÇ=Äó=íÜêÉ~í=EëÉÉ=_çñ=cÔcçê=Éñ~ãJ
éäÉI=äççâáåÖ=~í=íÜÉ=Äçñ=çå=íÜÉ=Äçííçã=äÉÑí=ïÉ=
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 Step 4 - Examine and Refine Your Species Selection Data (Summary Tables)  Box F 
Tick the check box to edit 
your data directly within the 
summary table, rather than 
revising data by candidate 
species under the Selection 
Criteria tab. 

Only the 
Current 
Conservation 
Status (CCS) 
data can be 
edited here. 

These column numbers 
correspond to the human 
activities listed under the 
Parameter Specifications
tab.  The name of the 
activity is shown when the 
mouse cursor is placed in 
the numbered cell (e.g., the 
first activity is ‘Hunting for 
trade as food’).

Look at this column to see 
the aggregate Threat Index
for each of the candidate 
species.  In this landscape 
the various otter species are 
highly impacted, as is the 
Big-headed turtle.

The total number of threats 
impacting each species is 
shown.  Keep in mind, 
however, that the highest 
number of total threats does 
not necessarily equate to 
the highest Threat Index
(e.g., although the Lesser 
Fish Eagle is impacted by 
the same number of threats 
as the otter its threat index 
is much lower).

The highest aggregate Threat 
Index across all species 
corresponds to ‘Hunting for trade 
as medicine/trophies’.  This also 
happens to impact the largest 
number of species (17 out of 21). 

The aggregate Threat Index is calculated using the equation:

Recovery time         Proportion affected
Urgency                     Severity            Probability of occurrence

The Threat Index for each species –
threat combination is calculated using the 
equation: (U + R) x S x Pa x Po
As an example, ‘Hunting for trade as food’
has a Threat Index value of: 
(3 + 2) x 3 x 4 x 1 = 60 for Sambar and 
(3 + 1) x 3 x 4 x 1 = 48 for Wild Pig.

a b c

Tick the check box to edit 
your data directly within the 
summary table, rather than 
revising data by candidate 
species under the Selection 
Criteria tab. 

Only the 
Current 
Conservation 
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correspond to the human 
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tab.  The name of the 
activity is shown when the 
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the numbered cell (e.g., the 
first activity is ‘Hunting for 
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the highest Threat Index
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As an example, ‘Hunting for trade as food’
has a Threat Index value of: 
(3 + 2) x 3 x 4 x 1 = 60 for Sambar and 
(3 + 1) x 3 x 4 x 1 = 48 for Wild Pig.

The Threat Index for each species –
threat combination is calculated using the 
equation: (U + R) x S x Pa x Po
As an example, ‘Hunting for trade as food’
has a Threat Index value of: 
(3 + 2) x 3 x 4 x 1 = 60 for Sambar and 
(3 + 1) x 3 x 4 x 1 = 48 for Wild Pig.

a b c
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ëÅçêÉë= Ñçê= É~ÅÜ=çÑ= íÜÉ= Å~åÇáÇ~íÉ= ëéÉÅáÉë= EëÉÉ=_çñ=eFK=
qÜÉ=åçêã~äáòÉÇ=ëÅçêÉë=Ñçê=íÜÉ=ÑáîÉ=ëÉäÉÅíáçå=ÅêáíÉêá~=~êÉ=
~ÖÖêÉÖ~íÉÇ= ~åÇ= ìëÉÇ= íç= ê~åâ= íÜÉ= Å~åÇáÇ~íÉ= ëéÉÅáÉëK==
`ÜÉÅâ=íç=ëÉÉ=íÜ~í=íÜáë=ê~åâáåÖ=ã~âÉë=ëÉåëÉ=Äó=êÉîáÉïJ
áåÖ= íÜÉ= áåÇáîáÇì~ä= ÅêáíÉêá~= ëÅçêÉëK= = qç= ÜÉäé=ïáíÜ= íÜáëI=
ÅäáÅâ=çå=~åó=çÑ= íÜÉ= Åçäìãå=ÜÉ~ÇáåÖë= íç= ëçêí= íÜÉ=Ç~í~=
Äó= íÜ~í=ÅçäìãåK= = få=çìê=Éñ~ãéäÉ=çÑ= íÜÉ=k~ã=h~ÇáåÖ=
i~åÇëÅ~éÉI= íÜÉ= íáÖÉê= ï~ë= íÜÉ= ÜáÖÜÉëí= ê~åâÉÇ= ëéÉÅáÉë=
EëÉÉ=_çñ=eFK==qÜáë=áë=åçí=ëìêéêáëáåÖ=ïÜÉå=óçì=ÅçåëáÇÉê=
íÜ~í=áíë=ÜÉíÉêçÖÉåÉáíóI=~êÉ~=~åÇ=ëçÅáçJÉÅçåçãáÅ=ëáÖåáÑáJ
Å~åÅÉ=ëÅçêÉë=~êÉ=ÜáÖÜ=EïáíÜ=ãÉÇáìã=íç=äçï=ëÅçêÉë=Ñçê=
îìäåÉê~Äáäáíó= ~åÇ= ÑìåÅíáçå~äáíó= êÉä~íáîÉ= íç= íÜÉ= çíÜÉê=
ëéÉÅáÉëFK= =oÉëìäíë=Å~å=~äëç=ÄÉ=Çáëéä~óÉÇ=Öê~éÜáÅ~ääó= íç=
ÑìêíÜÉê=êÉîáÉï=íÜÉ=çêáÖáå~ä=çê=åçêã~äáòÉÇ=ëÅçêÉëK=

Step 4 - Examine and Refine Your Species Selection Data (Aggregate Scores) 

=
=Review the number of habitats used by each species or the number of species using each habitat type, for example. 

Step 4 - Examine and Refine Your Species Selection Data (Summary Graphs) Box G 

=
=Review the ranking of the candidate species according to their aggregate score across all five selection criteria as well 
as the rankings by individual criterion (click on the Heterogeneity (H), Area (A), Vulnerability (V), Functionality (F) or Socio-
Economic (S-E) column to sort entries in ascending order). 

Step 4 - Examine and Refine Your Species Selection Data (Aggregate Scores) Box H=
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ë~ãÉ= ÉÑÑÉÅí= ~ë= êÉãçîáåÖ= ëéÉÅáÉë= íÜ~í= ~êÉ= åçí=
ÅìêêÉåíäó= ÅêáíáÅ~ääó= íÜêÉ~íÉåÉÇ=ïáíÜ= äçÅ~ä= ÉñíáêJ
é~íáçå= Ñêçã= íÜÉ= Å~åÇáÇ~íÉ= äáëí=ÄÉÑçêÉ= ëÉäÉÅíáçå=
éêçÅÉÉÇëK=
=

b. Run the species selection routine 
i~åÇëÅ~éÉ=péÉÅáÉë=~êÉ=ëÉäÉÅíÉÇ=ÄóW=
NK=̀ ~äÅìä~íáåÖ=íÜÉ=~ÖÖêÉÖ~íÉ=ëÅçêÉ=çÑ=É~ÅÜ=Å~åJ
ÇáÇ~íÉ=ëéÉÅáÉë=E^êÉ~=oÉèìáêÉãÉåíë=H=eÉíÉêçJ
ÖÉåÉáíó= H= sìäåÉê~Äáäáíó= H= cìåÅíáçå~äáíó= H=
pçÅáçJÉÅçåçãáÅ= páÖåáÑáÅ~åÅÉFI= ~åÇ= ê~åâáåÖ=
íÜÉ= ëéÉÅáÉë= áå= ÇÉëÅÉåÇáåÖ= çêÇÉê= Ä~ëÉÇ= ìéçå=
íÜÉ=~ÖÖêÉÖ~íÉ= ëÅçêÉK= = fÑ= ~=åìãÄÉê=çÑ= ëéÉÅáÉë=
~êÉ= ïáíÜáå= íÜÉ= j~êÖáå= çÑ= bêêçê= êÉä~íáîÉ= íç=
íÜÉ= íçé= ê~åâÉÇ= ëéÉÅáÉëI= íÜÉ= ëçÑíï~êÉ= é~ìëÉë=
íç= ~ääçï= Ñçê= ã~åì~ä= ëÉäÉÅíáçå= çÑ= íÜÉ= åÉñí=
ëéÉÅáÉë= íç= áåÅäìÇÉ= áå= íÜÉ= ëìáíÉ= çÑ=i~åÇëÅ~éÉ=
péÉÅáÉëK= =líÜÉêïáëÉI= íÜÉ=ÜáÖÜÉëí=ê~åâÉÇ=ëéÉJ
ÅáÉë=áë=ëÉäÉÅíÉÇ=~ë=íÜÉ=Ñáêëí=i~åÇëÅ~éÉ=péÉÅáÉëK==

OK=bäáãáå~íáåÖ=~ää=Ü~Äáí~íëI=ã~å~ÖÉãÉåí=òçåÉëI=
~åÇ= íÜêÉ~íë= êÉéêÉëÉåíÉÇ= Äó= íÜÉ= Ñáêëí= i~åÇJ
ëÅ~éÉ= péÉÅáÉë= ~åÇ= êÉÅ~äÅìä~íáåÖ= íÜÉ= eÉíÉêçJ
ÖÉåÉáíó= ~åÇ= sìäåÉê~Äáäáíó= ÅêáíÉêá~= ëÅçêÉë=
Ä~ëÉÇ=çå= íÜÉ=êÉã~áåáåÖ=ìåêÉéêÉëÉåíÉÇ=Ü~ÄáJ
í~íëI=ã~å~ÖÉãÉåí=òçåÉëI=~åÇ=íÜêÉ~íëK==

Step 5: Use the software as a 
 decision support tool to  
 select your complementary 
 suite of Landscape Species 
 

qÜÉ= ëìáíÉ= çÑ= i~åÇëÅ~éÉ= péÉÅáÉë= Ñçê= óçìê= ëáíÉ= áë=
~ëëÉãÄäÉÇ=Äó=ÅÜççëáåÖ=ÜáÖÜäóJê~åâÉÇ=Å~åÇáÇ~íÉ=
ëéÉÅáÉë=íÜ~í=ÅçãéäÉãÉåí=É~ÅÜ=çíÜÉê= áå=íÉêãë=çÑ=
Ü~Äáí~í= êÉèìáêÉãÉåíëI= íÜÉ= ã~å~ÖÉãÉåí= òçåÉë=
íÜÉó= ìëÉ= ~åÇ= íÜÉ= íÜêÉ~íë= íÜ~í= íÜÉó= ÉåÅçìåíÉêK==
qç=éêçÅÉÉÇ=ïáíÜ= íÜÉ= ëÉäÉÅíáçå=éêçÅÉëë= EëÉÉ=_çñ=
fFW=
=

a. Define the parameters controlling  
selection and complementarity 

aÉÑáåÉW= ENF= íÜÉ=j~êÖáå=çÑ=bêêçê= íç=~ÅÅçìåí= Ñçê=
íÜÉ=ìåÅÉêí~áåíó=áå=íÜÉ=ëÉäÉÅíáçå=Ç~í~=~åÇ=ã~åìJ
~ääó=ëÉäÉÅí=~ãçåÖ=ëéÉÅáÉë=ïáíÜ=ëáãáä~ê=~ÖÖêÉÖ~íÉ=
ëÅçêÉëX=EOF=íÜÉ=ÅìíJçÑÑ=î~äìÉ=Ñçê=ïÜÉå=~å=áåÇáîáÇJ
ì~ä= íÜêÉ~í= áë= êÉéêÉëÉåíÉÇ=Äó=~= ëéÉÅáÉë= áå= íÜÉ= ëÉJ
äÉÅíÉÇ= ëìáíÉ= çÑ= i~åÇëÅ~éÉ= péÉÅáÉëX= ~åÇ= EPF= = íÜÉ=
ãáåáãìã=`ìêêÉåí=`çåëÉêî~íáçå=pí~íìë=êÉèìáêÉÇ=
Ñçê=~=Å~åÇáÇ~íÉ=ëéÉÅáÉë=íç=ÄÉ=áåÅäìÇÉÇ=áå=íÜÉ=ëÉJ
äÉÅíáçå=éêçÅÉëëK= = pÉííáåÖ=~= ÅìíJçÑÑ=î~äìÉ=Ü~ë= íÜÉ=
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PK=oÉÅ~äÅìä~íáåÖ=íÜÉ=~ÖÖêÉÖ~íÉ=ëÅçêÉë=Ñçê=íÜÉ=êÉã~áåáåÖ=
Å~åÇáÇ~íÉ= ëéÉÅáÉëI= ê~åâáåÖ= íÜÉã=Ä~ëÉÇ=çå= íÜáë=åÉï=
ëÅçêÉI=~åÇ=ëÉäÉÅíáåÖ=íÜÉ=ÜáÖÜÉëí=ê~åâÉÇ=ëéÉÅáÉë=~ë=íÜÉ=
ëÉÅçåÇ=i~åÇëÅ~éÉ=péÉÅáÉëK==^Ö~áå=íÜÉ=ëçÑíï~êÉ=ïáää=
é~ìëÉ= áÑ=çíÜÉê=ëéÉÅáÉë=ëÅçêÉë=~êÉ=ïáíÜáå=íÜÉ=j~êÖáå=
çÑ=bêêçêK=

QK=oÉéÉ~íáåÖ= ëíÉéë= O= J= P= íç= ëÉäÉÅí= ~ää= ëìÄëÉèìÉåí= ëéÉJ
ÅáÉëK==

RK=qÉêãáå~íáåÖ= ïÜÉå= ~ää= íÜÉ= Ü~Äáí~íëI= íÜêÉ~íëI= ~åÇ=
ã~å~ÖÉãÉåí= òçåÉë= ~êÉ= êÉéêÉëÉåíÉÇ= Äó= íÜÉ= ëìáíÉ= çÑ=
ëÉäÉÅíÉÇ=i~åÇëÅ~éÉ=péÉÅáÉëK=

qÜáë=éêçÅÉëë=Ñ~îçêë=ëéÉÅáÉë=íÜ~í=ã~ñáãáòÉ=íÜÉ=åìãÄÉê=
çÑ= åÉï= Ü~Äáí~íëI= íÜêÉ~íëI= ~åÇ=ã~å~ÖÉãÉåí= òçåÉë= åçí=
êÉéêÉëÉåíÉÇ=Äó=ëéÉÅáÉë=~äêÉ~Çó= áå= íÜÉ=ëìáíÉI=ïÜáäÉ=~äëç=
ÅçåëáÇÉêáåÖ= íÜÉ= ^êÉ~I= cìåÅíáçå~äáíóI= ~åÇ= pçÅáçJ
ÉÅçåçãáÅ=páÖåáÑáÅ~åÅÉ=ëÅçêÉë=çÑ=Å~åÇáÇ~íÉ=ëéÉÅáÉëK=

=

c. Examine and  Refine Your Results 
`çåëáÇÉê= óçìê= áåáíá~ä= êÉëìäíë= ~åÇ= êÉéÉ~í=
íÜÉ= ëÉäÉÅíáçå= éêçÅÉëë= ïÜáäÉ= ÉñéÉêáãÉåíJ
áåÖ=ïáíÜ= ÇáÑÑÉêÉåí= ëÉäÉÅíáçå= ëÅÉå~êáçë= íç=
Åçãé~êÉ=íÜÉ=êÉëìäíë=ÄóW=ENF=`ÜççëáåÖ=ÇáÑJ
ÑÉêÉåí= ëéÉÅáÉë= ïÜÉå= íÜÉ= ëçÑíï~êÉ= ~ëâë=
óçì=íç=ÅÜççëÉ=~ãçåÖ=ëéÉÅáÉë=ïáíÜáå=íÜÉ=
j~êÖáå=çÑ=bêêçêX=EOF=`Ü~åÖáåÖ=íÜÉ=j~êJ
Öáå= çÑ= bêêçê= î~äìÉX= EPF= `Ü~åÖáåÖ= íÜÉ=
î~äìÉ= Ñçê= `ìêêÉåí= `çåëÉêî~íáçå= pí~íìëX=
EQF=`Ü~åÖáåÖ= íÜÉ=qÜêÉ~í=oÉéêÉëÉåí~íáçå=
î~äìÉX= ERF=`Ü~åÖáåÖ= íÜÉ= î~äìÉ= Ñçê= iÉîÉä=
çÑ=rëÉ=êÉèìáêÉÇ=íç=êÉéêÉëÉåí=É~ÅÜ=Ü~Äáí~í=
EÉKÖKI= ëÉííáåÖ= ~= î~äìÉ= çÑ= P= Ñçê= oáé~êá~å=
Ü~Äáí~íë=áå=k~ã=h~ÇáåÖ=i~åÇëÅ~éÉ=~ÇÇë=
lííÉê=íç=íÜÉ=ëìáíÉ=çÑ=i~åÇëÅ~éÉ=péÉÅáÉëFK=

Calculating Aggregate Scores 
 

 

Once all the data have been entered, then the raw and normalized scores for the heterogeneity, area requirements, vul-
nerability, ecological functionality, and socio-economic criteria can be calculated and displayed for each of the candidate 
species.  The maximum possible score within each selection criterion category varies and thus category scores are nor-
malized.  The normalized scores are calculated by scaling each species' score within each of the five selection criterion 
categories according to the maximum score in that category, so that all values fall between zero and one.  These normal-
ized scores are then aggregated and used to rank the candidate species, which avoids inadvertent weighting by any one 
selection criterion.  The individual criterion scores are calculated as follows: 

Heterogeneity (H): The heterogeneity score for a candidate species is calculated by summing level of use values across 
all habitat types and adding this to the summed level of use values across all management zones.  The habitat level of 
use score is given a 2/3 weight when calculating the score for heterogeneity, and the management zone use score is 
given a 1/3 weight.  Note that during complementarity, as habitats and management zones are covered by species 
added to the suite of Landscape Species, the heterogeneity score is recalculated for those candidate species that have 
not yet been selected. 

Area requirements (A): The original home ranges are scaled to fall in the interval [0,3] (i.e., the maximum home range 
value entered will correspond to 3).  In the case of binned home range values, the number of home range intervals is 
used to scale the home ranges.  The area score for a given candidate species is calculated by adding the scaled home 
range to the proportion of the natural landscape occupied by the species.  The area score is incremented by one if it was 
indicated that there is evidence of long dispersal distances for the species.  The area score is also incremented by one if 
it was indicated that connectivity matters for the species. 

Vulnerability (V): The vulnerability score for each candidate species is calculated by: Threat Index + (1-Current Conserva-
tion Status).  The Threat Index for a particular species is calculated by summing the quantity (U + R) x S x Po x Pa over all 
threats and then scaling it to a 0-1 range based on the highest raw Threat Index amongst the candidate species (U de-
notes Urgency and Po the Probability of Occurrence of a threat in the landscape, while R denotes the Recovery Time if 
the threat were removed, S the Severity of the threat, and Pa the proportion of the local distribution affected by the 
threat for a given candidate species).  This index reflects the characteristics of each threat and scales them according to 
their overall importance.  For example, a threat with a very low probability of occurrence will obtain a low score regard-
less of its severity.  The same is true for threats affecting only a small proportion of the landscape.  For species with high 
Current Conservation Status, i.e. those doing well, the vulnerability score reflects only (or mainly) the Threat Index. 

Ecological Functionality (F): To quantify the ecological significance of candidate species the number of ecological func-
tions in which they are involved and their significance in each are considered.  Significance values are summed over all 
possible functions to produce an overall functionality score for each candidate species.  No distinction is made between 
functionally significant species occurring at high versus low densities (i.e., ecologically pivotal vs. keystone species, re-
spectively). 

Socio-economic significance (S-E): The scores for each of the five socio-economic proxies are summed to obtain the 
socio-economic category score.  Assigning positive and negative values independently effectively separates species with 
both positive and negative value from those with one or the other.   
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=
=Step 5 - Use the Software as a Decision Support Tool to Select Your 

 Complementary Suite of Landscape Species 

Results of the Landscape Species selection are color coded to 
make it easier to see corresponding results in other tables. As 
each species is selected the number of additional habitats, 
management zones, or threats it represents are also shown. 

Species within the Margin of Error are highlighted in green (the two fish species Pakheung & Pakhe here).  Spe-
cies removed from the selection process because they do not represent any additional habitats, management 
zones, or threats are highlighted in light red (i.e., Gaur and Sambar, because either Tiger, Wild Pig or Asian Ele-
phant cover these). The species added to the suite of Landscape Species at each stage is highlighted in beige.  

Margin of Error 
 
The Margin of Error stopping rule is meant to make the selection process sensitive to the potential uncertainty associ-
ated with the data entered for candidate species during the selection process.  If the aggregate score of one or more 
candidate species is within the Margin of Error (e.g., within 5%) relative to the top ranked species, the software will 
pause and ask you to manually select the next species to include in the suite of Landscape Species.  When making use 
of this flexibility in the selection process you might use one or more of the following to decide among species: (1) indi-
vidual criteria scores (e.g., heterogeneity, vulnerability, etc.); (2) the number of and kind of habitats and threats repre-
sented by each species; (3) ease of monitoring; (4) specific threats or habitats (e.g., species X is very threatened by 
poaching); (5) the Current Conservation Status variable within the Vulnerability criterion; (6) previous experience (e.g., 
much is known about the species or we are currently focusing on this species); (7) opportunity (e.g., there is money 
available to work on the species); (8) complementary species in terms of trophic level; and/or (9) different scenarios of 
a final suite of Landscape Species (proceed with the selection with each choice to see what happens to the final suite). 
=

Living Landscapes Program—Landscape Species Selection Software wildlife conservation society  15 

Box I 

Depending on your priorities, include a species in 
your suite of Landscape Species based on the 
aggregate score or individual criteria scores 
(heterogeneity, vulnerability or socio-economic) or 
simply include the species in the suite for other 
reasons (e.g., ease of monitoring, trophic level, 
opportunities).=

The software stops and asks for a manual selec-
tion between Wild Pig (the top ranked species) 
with a score of 4.048 and Asian Elephant (the 
second ranked species) with a score of 3.975 
(within the 5% Margin of Error).=

The number of additional habitats, threats, and 
management zones that each species within the 
Margin of Error represents.  Some redundancy in 
terms of how these elements are covered by the 
Landscape Species may be desirable. To avoid a 
suite of species that is too large, however, select 
species that provide more coverage (e.g., Wild Pig 
is more efficient in terms of management zone 
and threat representation, but Asian Elephant 
covers a greater number of habitats).=

Margin of Error:  Set a small Margin of Error (e.g., 1% ) if you have high 
confidence in your input data for the selection criteria and a larger 
value if you have low (e.g., 10%) or virtually no confidence (e.g., 15%)  
in your input data.  The default value is a 5% Margin of Error. =

During each step of the selection process the recalculated rank, aggre-
gate score, heterogeneity score, vulnerability score, as well as the origi-
nal area, functionality, and socio-economic scores for each species are 
shown.  The additional habitats, management zones, or threats repre-
sented by each remaining candidate species are shown too.=

Threat Representation:  Set the cut-off value (between 0.5 & 1, de-
fault value 0.5) for when an individual threat is represented by a spe-
cies.  For example, the maximum Threat Index value for ‘Hunting for 
trade as food’ is 60, thus any species with an index value of at least 30 
would represent this threat in this case. =

Conservation Status Representation:  Set the minimum Current Con-
servation Status required for candidate species inclusion in the selec-
tion process.  If the default value of 1 is used, all candidate species are  
entered into the selection process.  With a lower cut-off value (e.g., 
0.5), no species with a CCS value greater than 0.5 is considered for 
selection. =

Set the 3 parameters controlling selection and complementarity, then 
press the button to start the Landscape Species selection process.=

The habitats covered, management zones covered, threats covered 
results highlight when each of these were covered by adding a particu-
lar species to the suite.  The results are color coded by species to facili-
tate interpretation.=

Covered by Gibbon 

Covered by Serow=
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Contact 
 

Dr. Samantha Strindberg  
Living Landscapes Program/ 

Conservation Support 
Wildlife Conservation Society 

2300 Southern Blvd. 
Bronx, NY 10460 USA 

Email: conservationsupport@wcs.org 

Living Landscapes Program Manuals 
 

WCS’s Global Conservation Programs work to save wildlife 
and wildlands by understanding and resolving critical 
problems that threaten key species and large, wild 
ecosystems around the world. Simply put, our field staff 
make decisions about what causes the needs of wildlife and 
of people to clash, and take action with their partners to 
avoid or mitigate these conflicts that threaten wildlife and 
their habitat. Helping our field staff to make the best 
decisions is a core objective of the Living Landscapes 
Program. 

We believe that if conservation projects are to be truly 
effective, we must: (1) be explicit about what we want to 
conserve, (2) identify the most important threats and where 
they occur within the landscape, (3) strategically plan our 
interventions so we are confident that they will help abate 
the most critical threats, and (4) put in place a process for 
measuring the effectiveness of our conservation actions, and 
use this information to guide our decisions. The Living 
Landscapes Program is developing and testing, with our field 
programs, a set of decision support tools designed to help 
field staff select targets, map key threats, prepare 
conservation strategies, and develop monitoring frameworks. 
 
 

We describe the application of these tools in a series of 
technical manuals which are available by email from 
conservationsupport@wcs.org.   

Implement Actions 
and Measure 
Effectiveness

Work-plans and Budgets
Implement actions
Monitor progress

Define the 
context

Vision and scope
Threats mapping

Stakeholders

Design Approach and 
Measures of Success

Select targets
Create conceptual models

Build conservation landscapes
Monitoring frameworks

Review Progress and 
Revise Approach

Evaluate impacts
Adapt to changes

Share lessons learned

qêóáåÖ=ÇáÑÑÉêÉåí=i~åÇëÅ~éÉ=péÉÅáÉë=ëÉäÉÅJ
íáçå=ëÅÉå~êáçë=ã~ó=äÉ~Ç=íç=ÑìêíÜÉê=êÉÑáåÉJ
ãÉåí= çÑ= íÜÉ= ëÉäÉÅíáçå= Ç~í~K= = dáîÉå= íÜ~í=
ëéÉÅáÉë= êÉéêÉëÉåí~íáçå= áë= êÉèìáêÉÇ= Ñçê=
É~ÅÜ= Ü~Äáí~íI= íÜêÉ~í= ~åÇ= ã~å~ÖÉãÉåí=
òçåÉI=áí=áë=âÉó=íç=Å~êÉÑìääó=ÇÉÑáåÉ=íÜÉëÉ=áå=
~=ï~ó= íÜ~í= ~îçáÇë= äçëë= çÑ= âÉó= áåÑçêã~J
íáçåI= Äìí= óáÉäÇë= ~= êÉ~ëçå~Ääó= ëáòÉÇ= ëìáíÉ=
çÑ=i~åÇëÅ~éÉ=péÉÅáÉë=ìëÉÑìä= Ñçê=ÉÑÑáÅáÉåí=
ÅçåëÉêî~íáçå=éä~ååáåÖK= =cçê=Éñ~ãéäÉI= áå=
íÜÉ= k~ã= h~ÇáåÖ= i~åÇëÅ~éÉ= íÜÉ= íÜêÉ~í=
Ñêçã= ÄìêåáåÖ= ï~ë= ÉîÉåíì~ääó= êÉãçîÉÇI=
~ë= áí=ï~ë= åçí= ~ë= ÅêáíáÅ~ä= ~= íÜêÉ~í= ~ë= áåáJ
íá~ääó=éÉêÅÉáîÉÇK= =tÜÉå=ÇÉÑáåáåÖ=íÜêÉ~íëI=
~=êìäÉ=çÑ=íÜìãÄ=áë=íç=ëéäáí=íÜÉã=ìé=áÑ=íÜÉ=
áåíÉêîÉåíáçåë= ~êÉ= äáâÉäó= íç= ÄÉ= ÇáÑÑÉêÉåí=
EÜÉåÅÉ= íÜÉ= ÇÉÑáåáíáçå= çÑ= Ñçìê= íóéÉë= çÑ=
ÜìåíáåÖ=íÜêÉ~í=áå=çìê=Éñ~ãéäÉFK=
=
cìêíÜÉêãçêÉI= ÅçåëáÇÉê= ïÜáÅÜ= ëéÉÅáÉë=
íÜ~í=Çç=åçí=èì~äáÑó=~ë=i~åÇëÅ~éÉ=péÉÅáÉë=
ãáÖÜí= ëíáää= ÄÉ= áåÅäìÇÉÇ= ~ë= ÅçåëÉêî~íáçå=
í~êÖÉíë=~ë=ÚëéÉÅá~ä=ÉäÉãÉåíëÛ=EëÉÉ=é~ÖÉ=PFK==
=
lÄí~áå= ~= ëìãã~êó= çÑ= ëÉäÉÅíáçå= êÉëìäíë=
~åÇ=Éñéçêí= íÜÉã=Äó=ÅäáÅâáåÖ=çå=íÜÉ=bñJ
éçêí=íÜÉ=êÉëìäíë=ÄìííçåK=
=
d. Select your Landscape Species  
qÜáë= ëçÑíï~êÉ= áë= ÇÉëáÖåÉÇ= íç= ÄÉ= ~= ÇÉÅáJ
ëáçå=ëìééçêí= íççä=~åÇ=ïáää=éêçÄ~Ääó=åçí=
éêçîáÇÉ=íÜÉ=Ñáå~ä=ëìáíÉ=çÑ=i~åÇëÅ~éÉ=péÉJ
ÅáÉë= Ñçê= ~= é~êíáÅìä~ê= ëáíÉK= = `çåëáÇÉêáåÖ=
íÜÉ= ëçÑíï~êÉÛë= ëìÖÖÉëíáçåëI= ÅçãéáäÉ= ~=
ëìáíÉ=íÜ~í=ïáää=ÜÉäé=ÅçåëÉêîÉ=íÜÉ=ÅçãéçJ
ëáíáçåI= ÅçåÑáÖìê~íáçå= ~åÇ= ÉÅçäçÖáÅ~ä=
éêçÅÉëëÉë=çÑ=íÜÉ=ä~åÇëÅ~éÉK= =qÜÉ=ëìáíÉ=áë=
áåíÉåÇÉÇ=íç=ÜÉäé=ÇÉÑáåÉW=ENF=íÜÉ=ÉñíÉåí=çÑ=
íÜÉ=ä~åÇëÅ~éÉX=EOF=ÉÅçäçÖáÅ~ääó=~ééêçéêáJ
~íÉ= ã~å~ÖÉãÉåí= ìåáíëX= ~åÇ= EPF= ïÜÉêÉ=
~åÇ= ïÜÉå= ÅçåëÉêî~íáçå= ÅçåÑäáÅíë= çÅÅìêK==
qÜáë= áåÑçêã~íáçå= Å~å= íÜÉå= ÄÉ= ìëÉÇ= íç=
ÜÉäé=ëíêìÅíìêÉ=ÅçåëÉêî~íáçå=~ÅíáçåëK=

qÜáë= éìÄäáÅ~íáçå= áë= ã~ÇÉ= éçëëáÄäÉ= Äó= íÜÉ= ÖÉåÉêçìë= ëìééçêí= çÑ= íÜÉ=
^ãÉêáÅ~å= éÉçéäÉ= íÜêçìÖÜ= íÜÉ= råáíÉÇ= pí~íÉë= ^ÖÉåÅó= Ñçê= fåíÉêå~íáçå~ä=
aÉîÉäçéãÉåí=Erp^faFI=ìåÇÉê==íÜÉ=íÉêãë=çÑ=`ççéÉê~íáîÉ=^ÖêÉÉãÉåí=kçK=
i^dJ^JMMJVVJMMMQTJMMK= qÜÉ= ÅçåíÉåíë= ~êÉ= íÜÉ= êÉëéçåëáÄáäáíó= çÑ= íÜÉ=
iáîáåÖ= i~åÇëÅ~éÉë= mêçÖê~ã= çÑ=t`p= ~åÇ= Çç= åçí= åÉÅÉëë~êáäó= êÉÑäÉÅí= íÜÉ=
îáÉïë=çÑ=rp^fa=çê=íÜÉ=råáíÉÇ=pí~íÉë=dçîÉêåãÉåíK=




